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Disclaimer

PANTONE® Colors displayed in the software application or in the user 
documentation may not match PANTONE-identified standards. Consult 
current PANTONE Color Publications for accurate color. PANTONE® and 
other Pantone trademarks are the property of Pantone LLC.  
© Pantone LLC, 2012

Pantone is the copyright owner of color data and/or software which are 
licensed to (Luxion Aps) to distribute for use only in combination with 
KeyShot. PANTONE Color Data and/or Software shall not be copied onto 
another disk or into memory unless as part of the execution of KeyShot 
material library.
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KeyShot is an entirely CPU based and standalone render engine for 
3D data. It is designed to simplify the process of creating computer-
generated, photo-realistic images. Its simplicity and CPU based 
architecture make KeyShot one of the most widely used rendering 
solutions among designers, engineers, and CG professionals worldwide.

•	CPU Rendering

•	HDRI Lighting

•	Physically Accurate Materials

•	Stereoscopic Viewing

KeyShot Overview
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CPU Based Rendering
KeyShot is entirely CPU based and it is designed to utilize 100% of all 
CPU power available in your system. The render engine's performance 
is approximately linear in scale to the number of processor cores in your 
system. A higher number of cores yields faster rendering speeds.

Why CPU?
KeyShot delivers fast, noise-free results thanks to the powerful 
algorithms behind the render engine.  The CPU is the only module 
in your computer capable of calculating such algorithms.  Because 
KeyShot is 100% CPU powered, there is no need for special graphics 
cards or hardware. In addition, Your 3D data is stored in RAM and does 
not dependent on the VRAM in your graphics card. This makes KeyShot 
a mobile rendering solution available to anyone.

KeyShot Overview > CPU Rendering
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HDR Lighting
High dynamic range lighting (HDR lighting) is a technique used across 
the CG industry for lighting 3D models easily and realistically. This 
lighting technique makes use of HDR images which contains a wide 
range of color intensity. KeyShot uses HDR images to accurately 
simulate differences in brightness; from a simple LED all the way up to 
the intensity of the sun.

Any model imported into KeyShot is placed within the mapped 
HDR image.  No initial lighting setup is necessary for you to achieve 
immediate realistic lighting.  

For more information on tuning your lighting see the section on 
adjusting lighting.

KeyShot Overview > HDR Lighting

The same scene but the camera has been pulled back to reveal the 
sphere that contains the HDR image which is casting the light.

Realistically lit 3D model.



KeyShot®
   Manual

The Science Behind the Materials
All KeyShot materials are scientifically accurate and have physical 
properties based on real world materials. The material types contain 
only the properties necessary for creating that specific material type. 
For example, you won’t find a property under the “Glass” material that 
will make it look like a metal. This makes setting up realistic materials 
extremely easy and foolproof.

Included:

500+ materials
Axalta Coating Systems® materials
Mold-Tech® materials

KeyShot Overview > Physically Accurate Materials
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Stereoscopic Viewing(3D)
KeyShot gives you the ability to view you models in realtime 3D. 
(*hardware not included)

How to Enable It
Enabling stereoscopic viewing can be found under "View" -> 
"Stereoscopic settings". You will need 3D enabling hardware:

3D monitor

3D graphics card (support 3D vision, or OpenGL quad buffering)

3D glasses

KeyShot Overview > Stereoscopic Viewing
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Directory Structure > Overview

KeyShot Resources
KeyShot has a default directory structure called KeyShot Resources. 
Assets such as materials, environments, and textures are stored here. 
When you open a BIP file, KeyShot will automatically read the KeyShot 
resources folder and load any resource files applied to the scene.

KeyShot Resources contains the following sub folders:

Animations
Backplates
Colors
Downloads
Environments
Favorites
Materials
Material Templates
Models
Renderings
Scenes
Textures

You can specify the location of the KeyShot resources folder in the 
folder preferences.
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Animations:
Animations will be saved to this folder by default.  At render time, other 
locations can be specified inside the Render Options window.

Backplates:
The KeyShot Library loads backplates from here and saves imported 
backplates to this folder by default.

Colors:
The KeyShot Library loads color library files from here and saves 
imported color library files to this folder by default.

Downloads:
Resources downloaded from the KeyShot Cloud will be saved here.

Environments:
The KeyShot Library loads environments from here and saves imported 
environments to this folder by default.

Favorites:
This folder is empty until a favorite list of resources is created.  Once 
created, the favorite list is saved to this location as a .XML file.

Materials:
The KeyShot Library loads materials from here and saves imported 
materials to this location by default.

Material Templates:
This folder is empty until a material template is created.  Once created, 
the material template is saved to this location.

Models:
This folder contains standard primitives that you can import into 
KeyShot. 

Renderings:
Renderings will be saved to this folder by default.  At render time, other 
locations can be specified inside the Render Options window.

Scenes:
This folder contains sample scenes that you can only with KeyShot.  
These scenes are saved as "Better Than Photo" BIP files.

Textures
The Keyshot Library loads textures from here and saves imported 
textures to this folder by default.

Directory Structure > Overview
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Directory Structure > PC Location

Location
After KeyShot 5 is installed, a "KeyShot 5 Resources" shortcut is created 
on your desktop.  By default, this shortcut points to: 

Documents - > KeyShot 5

Setting Permissions
You must have read and write permissions to your KeyShot 5 folder 
in order to save renders, animations, and more.  Here's how to set 
permissions:

1.	 Right-click the KeyShot 5 resources folder and select "Properties".

2.	 Go to the Security tab and highlight your group or user name

3.	 Click the Edit button

4.	 Set permissions to "Full Control"

5.	 Click Apply and OK
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Directory Structure > Mac Location

Location
On a Mac your KeyShot 5 resources folder is saved inside the 
Application Support:

Library -> Application Support -> KeyShot 5

Setting Permissions
You must have read and write permissions to your KeyShot 5 folder 
in order to save renders, animations, and more.  Here's how to set 
permissions:

1.	 Right-click the KeyShot 5 resources folder and select "Get Info".

2.	 Expand "Sharing & Permissions" and unlock access

3.	 Change all privileges to "Read & Write"

4.	 Click the settings button and select "Apply to enclosed items..."

5.	 Click OK and close the window

Resources Folder Location

License File Location
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Licensing 

Licensing
The standard node locked license is serial code based and can be active 
on one machine at a time. However, you can transfer your license to 
three machines as many times as you want.

Contents

•	Installing Your License

•	Transferring Your License
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Licensing > Installing

Automatic Install
When you receive your ‘keyshot5.lic’ file save it to your machine. 
Next, start KeyShot and select ‘install license’ and browse to the 
‘keyshot5.lic’ file. If your license fails to copy, check to ensure you 
have full permissions set on your Keyshot resources folder on PC and 
full permissions set on the KeyShot application ‘package contents’ on 
Mac. Click one of the following links for information on setting your 
permissions on PC or Mac.

Manual Install
When you receive your ‘keyshot5.lic’ file you can manually copy it to 
the Keyshot resources directory for PC or to the application package 
contents on Mac.
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Licensing > Transferring

Transferring overview
During the license transfer process, an Internet connection is required. 
Once the license has been successfully transferred KeyShot can run 
without being connected to the Internet.

Transferring your license
To transfer your license on PC, ensure you are connected to the Internet 
on the active machine. Start KeyShot and go to ‘File -> Deactivate 
license on this machine’. Then, ensure the new machine is connected 
to the Internet and that KeyShot is installed. Start the software, fill out 
your information on the activation screen, and press ‘Next’. On the 
following screen you will be asked for your KeyShot serial code(s). Type 
in your information and press ‘Next’ to finalize the activation.
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User Interface 

•	Hotkeys

•	Menu Bar

•	Preferences

•	Realtime Window

•	Toolbar

•	Ribbon

•	KeyShot Cloud

•	Library

•	Project Window 

•	Render Options



KeyShot®
   Manual

User Interface > Hotkeys

Accessing the Hotkey Reference Menu
Learning and using the hotkeys will speed up 
the process of working inside KeyShot. You can 
access the list of hotkeys and their functionality by 
pressing the ‘K’ key on PC or Mac.
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User Interface > Menu Bar

•	File

•	Edit

•	Environment

•	Camera

•	Render

•	Settings

•	View

•	Window

•	Help
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User Interface > Menu Bar > File

Menu Bar
File
New
Opens a new blank scene in KeyShot.

Import
Imports a 3D file into an open or new scene. See Importing section for 
more details.

Open...
Opens a KeyShot scene, or opens the import panel to open the model in 
KeyShot.

Open Recent
KeyShot lists the last 10 scenes that were opened/saved that you can 
quickly open.

Save
Save the currently open scene in KeyShot

Save As...
Save the current scene in Keyshot with the option to change the name 
of the file.

Save Package
Save a KeyShot Package which includes the model, materials, 
environments, textures, cameras, and backplates used in the scene.

Revisions Manager
Enable Backup options under Preferences > General. See Preferences 

section for more details.

Export
KeyShot Can Export to .OBJ, .ST L, and ZPR file formats.

Upload to GrabCAD
Upload a rendering to GrabCAD.com. Login is required.  
See GrabCAD.com for details.

Exit
Quits out of KeyShot
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User Interface > Menu Bar > Edit

Menu Bar
Edit
Undo
Undo previous actions. 

Add Geometry
Add pre-installed primitives into your scene. You can also place 
commonly used models into the "Models" folder in your KeyShot 5 
Resources directory.

Clear Geometry
Clears all geometry in the scene.

Set Scene Units
Change the set units used in the scene. For accurate results, use the 
same units the model was modeled in.

Preferences
Set KeyShot Preferences. See Preferences section for more details.
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User Interface > Menu Bar > Environment

Menu Bar
Environment
HDRI Editor (PRO)
Opens the HDRI editor. See HDRI editor for more details

Background
Toggle background mode from lighting environment, color, and 
backplate image. See background for more information.

Ground Shadows
Toggle ground shadows on and off. See ground shadows for more 
information.

Ground Reflections
Toggle ground reflections on and off. See ground reflections for more 
information.
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User Interface > Menu Bar > Camera

Menu Bar
Camera
Cameras
Choose a saved camera. Cameras that are saved from your list of saved 
cameras is populated here. See camera list for more information.

Lock Camera
Lock the camera in your realtime view. See camera tab for more 
information.

Add Camera
Add a camera to your saved camera list. See camera list for more 
information.

Add Viewset
Add a viewset to your saved camera list. See camera list for more 
information.

Perspective
Toggle camera to perspective mode. See lens settings for more 
information.

Orthographic
Toggle camera to orthographic mode. See lens settings for more 
information.

Stay Above Ground
Toggle camera to stay above ground. See position and orientation for 
more information.

Grid
Enable grid. See position and orientation for more information.

Ground Grid
Enable ground grid. See lens settings for more information.

Match Backplate
Enable the match backplate tool. See match backplate for more 
information.
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User Interface > Menu Bar > Render

Menu Bar
Render
Pause Realtime Render
Enable pause realtime render.

Performance mode
Toggle performance mode. See lens settings for more information.

Save Screenshot
See save screenshot for more information

Add to Queue
See render queue for more information.

Render
Opens the render options. See render options for more information.
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User Interface > Menu Bar > Settings

Menu Bar
Settings
Resolution presets
Choose from commonly used resolution presets.

Lock Aspects
Lock the aspect ratio from being changed. See settings for more 
information.

Lock Resolution
Lock resolution dimensions from being changed. See settings for more 
information.

Self Shadows
Enables self shadows. See render queue for more information.

Global Illumination
Enables global illumination. See global illumination for more 
information.

Ground Illumination
Enables ground illumination. See ground illumination for more 
information.

Focused Caustics
Enables focused caustics. See focused caustics for more information.
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User Interface > Menu Bar > View

Menu Bar
View
Scene Sets
Switch between next and previous scene sets.

Show Fullscreen
Enables fullscreen mode.

Presentation Mode
Enables presentation mode.

Heads-Up Display
Hides or shows the heads- up display which contains frames per 
second, amount of triangles in the scene, current scene resolution, and 
the current focal length of the camera.

Show Coordinate Legend
Hides or shows the coordinate legend on the lower left corner of the 
realtime render window.

Selection Outlines
Toggles selection outlines to be shown.

Show Light Sources
Hide or show physical light sources.

Stereoscopic Settings
Requires a video card with stereoscopic capabilities and 3D glasses to 
enable this feature.
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User Interface > Menu Bar > Window

Menu Bar
Window
Show Toolbar
Toggle toolbar on/off.

Show Ribbon
Toggle Ribbon on/off.

Enable Docking
When enabled, windows can be docked in the realtime render window.

Dock Windows
Auto-docks all open windows to default locations.

KeyShot Cloud
Hide/show the KeyShot Cloud window.

Project
Hide/show the project window.

Library
Hide/show the library window.

Animation
Hide/show the animation window.

KeyShot VR
Hide/show the KeyShotVR window.

Material Templates
Opens the material template window. See material templates for more 
information
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User Interface > Menu Bar > Help

Menu Bar
Help
Manual
Opens The KeyShot Manual

Online Manual
Opens the KeyShot Online Manual in a default browser window.

Learning
Opens the Keyshot Learning page for tutorials, webinars, and quicktips.

Register License
Opens the KeyShot Registration window.

Activate Animation
If you have purchased the animation add-on separately, click here to 
activate it.

Activate KeyShotVR
If you have purchased the KeyShotVR add-on separately, click here to 
activate it.

Deactivate License on this Computer
Use this to deactivate your license to be used on a different computer.

Show License Information
Shows Keyshot version and active licenses.

Disclaimers
Opens disclaimers pertaining to KeyShot partners.

Check for Updates
Checks Online for the latest version of KeyShot. Requires Internet 
connection.

Log
Opens log window for errors.

About
Displays KeyShot 5 "about" window.
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User Interface > Preferences 

•	General

•	Interface

•	Folders

•	Plugins 

•	Color Management

•	Advanced
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User Interface > Preferences > General

General
Show News Window at Application Start Up
Display News and recently opened window at start up.

Adjust aspect ratio to backplate
Automatically resize the realtime window to the same aspect ratio of 
any backplate image that is loaded into the realtime window.

Auto Update
Prompt the user to download and run the update installer when a 
newer version becomes available.

Pause Realtime Render After
Select an amount of time from the menu to automatically pause the 
rendering and stop the usage of your CPU.

Screenshots
Ask where to save each screenshot
KeyShot will prompt the user to specify a location when saving a 
screenshot from the realtime window. You can also select file format 
and quality each screenshot is saved.

Save a camera with each screenshot
When checked, KeyShot will save a camera view for every screenshot 
that is saved out. These views can be accessed from the camera tab in 
the project window.
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User Interface > Preferences > General

Material Environment Image
This is the path to the environment that renders the materials inside the 
library. Changing the path will render the materials ball in the library 
with the environment that was chosen.

Back Up Versions
Enables iterative back up saves.

KeyShot Cloud
Displays login status.

Notify When an Import Starts
KeyShot will display a message every time an import is started.

Notify When an Import Finishes
KeyShot will display a message when an import finishes uploading.

Clear Cache
Clears temporary files used for KeyShot Cloud.
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User Interface > Preferences > Interface

Interface
Language
Select the desired language in the menu.

Theme
Select desired color for the KeyShot UI

Background Brightness
Change the background of the realtime view.

Selection Outlines
Displays an orange outline around selected parts.

Use CPU for Selection Outlines
Enable this if selection outlines are unstable on GPU

KeyShot 2 Style Material Paste/Link
Use KeyShot 2 legacy paste/link hotkeys.

Include Camera Movements in Undo Stack
This will include all camera movements in the undo stack.

Reverse Camera Distance Scrolling
Reverse the scrolling on the camera when dollying the camera.

Enable Flyouts in Right Click menu
Additional options will be available on right click Menus.

Show Project Materials View in Material Edit Tab
All in-project materials will be displayed.
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User Interface > Preferences > Interface

3D Mouse Sensitivity:

Control the sensitivity of a 3Dconnexion mouse.

Restrict to Dominant Axis:

Limit the range of motion on the 3D mouse to one dominant axis. For 
example, if a user is moving the mouse both forward and sideways, 
the camera will move in the more dominant direction - not both at the 
same time.

Invert Axis

Invert Axis will simulate moving the model as opposed to the camera 
moving around the model.
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User Interface > Preferences > Folders 

Folders
The folders tab will allow you to specify your KeyShot Resources as well 
as set up shared folders.

Shared folders will allow you to point KeyShot to folder that is shared 
on a server or local computer to access the files. To use shared folders 
you will need to select “customize each folder” and click the folder 
icon on the right. The Configure Folders dialog will open as seen. From 
their you can select the ( + ) button to add a new folder path. Selecting 
a folder and clicking ‘Edit’ will allow you to edit that folder and change 
the path or changing to a default folder. You will need one default folder 
at all times.

All shared folders will show inside of the library.
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User Interface > Preferences > Plugins 

Plugins
All plugins that are installed for KeyShot to use will be displayed here.
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User Interface > Preferences > Color Management

Color Management
Gamma Correct Color Dialog Selection
Gamma corrects color values when selecting them manually in the 
color picker.

Gamma correct color library:
Enable to allow for gamma correct colors to be shown in the library.
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User Interface > Preferences > Advanced

Advanced
Fast realtime Updates
Enable smooth camera moves while navigating your scene.

Graphics Effects
Allow access the Bloom and Vignetting effects.

Use Gloss Instead of Roughness for Materials
This will change all parameters for roughness to gloss. Restarting 
KeyShot is required to take affect.

Link Materials of Duplicate Parts
When enabled, parts that are duplicated will have materials linked.

Respect Animation Ordering
When enabled, the next animation origin follows the previous 
animation origin.

Output Window Memory Limit
This controls the amount of memory reserved for the image buffer in 
the output window. If the rendered image takes up more memory than 
this limit, it will be downscaled until below the limit. This is useful if you 
are rendering gigapixel images and your scene takes up a lot of memory 
as well. It does *not* affect the output image itself (as specified in 
the render settings), but *does* affect images saved directly from the 
output window.
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User Interface > Preferences > Advanced

Advanced
Live Linking
Live Linking allows installed plugins to establish a link between your 
3D modeling software and KeyShot. This keeps the software separate, 
allowing you to continue working and refining your model, then send 
all changes over to KeyShot with the click of a button. All without losing 
any views, materials, textures or animations already applied. Leave 
the live linking network port at default unless you are having problems 
with live linking capabilities. Contact support@luxion.com for more 
information.

Network
If you are behind a proxy server, you can fill in the server information 
here to allow KeyShot to connect to the Internet to activate the 
software and to automatically be informed of updates.

Log
This is an optional log that can be displayed to help with debugging. 
It will display different types of information that can help the KeyShot 
development and support teams troubleshoot issues that may arise.
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Realtime View
1. This is the realtime view. All realtime rendering of your 3D model 
will occur here. You can interactively move around your model by 
using the camera controls. You can adjust realtime render settings 
and performance by going into the settings tab in the project window. 
Models can be multi-select by hold SHIFT + LMB and dragging.

2. This is your main toolbar and will guide you through the process 
of creating images and/or animations. The icons are arranged in the 
chronological order, from importing your data, assigning materials, 
choosing lighting, setting up animations and finally rendering. The 
toolbar icons can be displayed in different sizes and you can choose to 
hide the text by right clicking on the toolbar and setting your options.

The toolbar can also be torn away from the bottom of the realtime 
view by hovering over the handle on the far left side and left click and 
dragging to move the toolbar freely. It can be snapped to the left side of 
the interface by dragging and hovering the toolbar over the left edge of 
the realtime view.

3. This is the ribbon which contains quick access to common tools used 
in KeyShot

User Interface > Realtime Window
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Realtime View
Docking windows can be activated by simply dragging the library, 
KeyShot Cloud, project or animation timeline near the edge of the 
realtime view. You are able to dock all windows at once by going to 
“View” - > “Dock Windows”.

User Interface > Realtime Window
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Tool Bar
KeyShot Cloud
Opens the KeyShot Cloud panel. See KeyShot Cloud section of the 
manual for more details.

Import
Opens import panel to import scenes and 3D data into Keyshot. See 
Importing, and Working With Data section for more detail.

Library
Opens the Library panel. See Library section for more details.

Project
Opens the Project panel. See Project Window section for more details.

Animation
Opens the Animation Panel. See Animation section for more details.

Render
Opens the Render Options panel. See Render Options section for more 
details

Screenshot
Takes a screenshot of the current state of your realtime render 
window. A camera will be automatically saved in your camera list. The 
screenshot will be saved in your renders folder.

User Interface > Toolbar
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Ribbon
CPU Cores
Select the amount of cores used for the realtime render window.

Pause
Pauses realtime rendering.

Previous/Next Scene Set 
Switches to previous or next saved scene set.

Previous/Next Camera
Switches to previous or next saved camera.

Lock Camera
Tumble, Pan, Dolly Camera
Use these controls to isolate the movement of your camera. Useful for 
workstations that use a mouse without a scroll wheel.

Perspective Slider
Quick access to perspective slider. For more details see Camera section.

Move Tool
Select model or part and activate tool button. For more details see 
Moving Models section.

HDRI Editor (Pro)
Opens HDRI Editor window. Also accessible via the environments tab. 
For more details see HDRI Editor section

NURBS Mode
Enables Nurbs Data to be rendered in the realtime rendering window.

Performance Mode
Enable to lower realtime render settings for faster performance. When 
enabled, an icon will display on the top right. Also accessible via the 
settings tab, as well as the hotkey

KeyShotVR Wizard
Opens the KeyShot VR wizard. For more details see KeyShotVR section.

User Interface > Ribbon
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KeyShot Cloud is an on-library where you can share your own custom 
materials and resources, as well as have access to resources uploaded 
by other KeyShot users. The KeyShot Cloud is fully integrated into the 
KeyShot workflow to make downloading and uploading your resources 
as easy as it is to use them.

•	User Interface

•	Creating an Account

•	Searching

•	Uploading/Downloading Resources

KeyShot Cloud
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User Interface
KeyShot Cloud is an on-library where you can share your own custom 
materials and resources, as well as have access to resources uploaded 
by other KeyShot users. The KeyShot Cloud is fully integrated into the 
KeyShot workflow to make downloading and uploading your resources 
as easy as it is to use them.

1. Search field

2. Thumbnails / list view toggle

3. Category Tabs

4. Search result counter

5. Search results

6. Details

7. "Like" Button

8. Add to Library

User Interface > KeyShot Cloud > User Interface

1

3
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7

8

4

2
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Creating an Account
Before you have access to the KeyShot Cloud, KeyShot will prompt the 
user to login with an existing account or to create a new one. You can 
also log in with an existing KeyShot Form login.

KeyShot will automatically log in the user after logging in. To manually 
log out of the KeyShot Cloud, click Edit>Preferences>General>Logout.

KeyShot Cloud > Creating an Account
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Searching
KeyShot Cloud has a robust search feature. You can type any keywords, 
as well as using the syntax of "@<user name" to search for resources 
created by a specific user.

The search results can be organized by the "Order By" and the "Results 
Since" pulldowns.

Click on a resource entry to bring up the details of that specific resource   
such as the creators name, size, description, clickable tags, and 
more. The details section will also contain the "download" button to 
Download the resource to your library, as well as a "Report" button to 
flag the resource for offensive material.

KeyShot Cloud > Searching
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Uploading Resources
To upload your custom resources to the KeyShot Cloud Click the 
"Upload" button on the bottom right of the KeyShot library panel.

You will be prompted to edit the name if you would like to change the 
name, as well as add a description and tags to help other users search 
for your resource. If you don't know what tags to use, you can click 
"suggestions" and KeyShot will auto generate tags for you.

After clicking next, a confirmation of resources to be uploaded will be 
displayed. Click "Upload" to send your resource to the cloud for other 
users to have access to.

Downloading Resources
To download a resource on the Cloud, click the "Add to Library" button 
on the resource you would like to download. The resource will be 
automatically downloaded to your downloads folder in the appropriate 
tab that you can move to an existing or custom folder.

KeyShot Cloud > Uploading/Downloading Resources
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User Interface > Library

•	Overview

•	Materials Tab

•	Colors Tab

•	Environments Tab

•	Backplates Tab

•	Textures Tab

•	Favorites Tab
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Library
This is where default assets such as materials, colors, environments, 
backplates and textures are stored. Any content displayed here is 
sourced from the locations set for KeyShot resources in the folders 
preferences. The different assets can be displayed by clicking on any of 
the upper tabs.

The library is setup to work like a file browser in an operating system. 
Folders can be added by manually placing them in the KeyShot 
resources folder through your OS, or they can be added by clicking the 
add folder button . Content can be refreshed by clicking the refresh 
button and content can be imported or exported by clicking either the 
import or export buttons. The library can also be searched by typing in 
the search field in the upper right corner.

The library is split horizontally into two view panes. The top pane 
shows the folder structure and the bottom pane shows the content of 
the currently highlighted folder as thumbnails. The thumbnail sizes can 
be scaled up or down by using the scale slider on the bottom of the 
library window.

You can drag and drop content from the library by clicking and dragging 
any item from the lower pane into the realtime window.

Any shared folders will also be shown below Shared Folders.

Folders with a lock sign on the folder, are set to read only. Permissions 
can be edited inside of the shared folders.

User Interface > Library
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Materials
The materials tab contains all your saved materials in your library.

Search
Type in any keyword to search for a material by name.

Add Folder 
Click this button to add custom material folders.

Settings
Contains: 
	 Refresh- Refresh material list if any changes were made. 
	 Import - Import a .KMP material file. 
	 Export - Export a .KMP material file.

Folder Tree
Contains the folder structure of the material folders.

Material Thumbnails
Mat ball swatches of materials within the selected folder.

List/Thumbnail Toggle
Switch between displaying the materials with thumbnails, or a list view.

Zoom Slider
Slide to change the size of the thumbnails use +/- to change in steps.

Upload to KeyShot Cloud
Click this button to upload a custom material to the KeyShot Cloud.

User Interface > Library > Materials Tab
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User Interface > Library > Colors Tab

Colors Tab
The colors tab contains all your saved colors in your library.

Search
Type in any keyword to search for a color by name.

Add Folder 
Click this button to add custom color folders.

Settings
Contains: 
	 Refresh- Refresh color list if any changes were made. 
	 Import - Import a .KCP or .CSV color file. 
	 Export - Export a .KCP color file.

Color Search
Opens color picker panel to search by closest color match.

Folder Tree
Contains the folder structure of the color folders. Contains folders for 
RAL and Pantone Color Libraries.

Color Swatches
Displays color swatches within the selected folder.

List/Thumbnail Toggle
Switch between displaying the color with thumbnails, or a list view

Zoom Slider
Slide to change the size of the thumbnails use +/- to change in steps
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User Interface > Library > Environments Tab

Environments Tab
The environments tab contains all your saved environments 
in your library.

Search
Type in any keyword to search for an environment by name.

Add Folder 
Click this button to add custom environments folders.

Settings
Contains: 
	 Refresh- Refresh environments list if any changes were made.  
	 Import - Import a .HDR, .HDZ, .EXR, .DDS file. 
	 Export - Export environment file.

Folder Tree
Contains the folder structure of the environment folders.

Environment Thumbnails
Thumbnails of environments within the selected folder.

List/Thumbnail Toggle
Switch between displaying the environments with thumbnails,  
or a list view.

Zoom Slider
Slide to change the size of the thumbnails use +/- to change in steps.

Upload to KeyShot Cloud
Click this button to upload a custom environment to the KeyShot Cloud.
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User Interface > Library > Backplates Tab

Backplates Tab
The backplates tab contains all your saved materials in your library.

Search
Type in any keyword to search for a backplate by name.

Add Folder 
Click this button to add custom backplate folders.

Settings
Contains: 
	 Refresh- Refresh backplate list if any changes were made. 
	 Import - Import an image file. 
	 Export - Export an image file.

Folder Tree
Contains the folder structure of the backplate folders.

Backplate Thumbnails
Thumbnails of backplates within the selected folder.

List/Thumbnail Toggle
Switch between displaying the backplates with thumbnails, 
or a list view

Zoom Slider
Slide to change the size of the thumbnails use +/- to change in steps.

Upload to KeyShot Cloud
Click this button to upload a custom backplate to the KeyShot Cloud.
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User Interface > Library > Textures Tab

Textures Tab
The textures tab contains all your saved textures in your library.

Search
Type in any keyword to search for a texture by name.

Add Folder 
Click this button to add custom texture folders.

Settings
Contains: 
	 Refresh- Refresh texture list if any changes were made. 
	 Import - Import an image file. 
	 Export - Export an image file.

Folder Tree
Contains the folder structure of the texture folders.

Texture Thumbnails
Thumbnails of textures within the selected folder.

List/Thumbnail Toggle
Switch between displaying the textures with thumbnails, or a list view.

Zoom Slider
Slide to change the size of the thumbnails use +/- to change in steps.

Upload to KeyShot Cloud
Click this button to upload a custom texture to the KeyShot Cloud.
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User Interface > Library > Favorites Tab

Favorites Tab
The favorites tab allows you to organize commonly used resources into 
groups for a faster workflow. Right click a resource in your library, and 
select add to favorites, and then select the folder you would like to add 
the resource to.

Search
Type in any keyword to search for a resource by name.

Add Folder 
Click this button to add a favorites folders.

Settings
	 Refresh- Refresh favorites list if any changes were made. 
	 Import - Import favorites. 
	 Export - Export Favorites.

Folder Tree

Contains the folder structure of the favorites folders. Each favorites 
folder contains categories for backplates, colors, environments, 
materials, and textures.

Favorites Thumbnails
Thumbnails of resources within the selected folder.

List/Thumbnail Toggle
Switch between displaying the favorites with thumbnails, or a list view.

Zoom Slider
Slide to change the size of the thumbnails use +/- to change in steps.
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User Interface > Project Window

•	Overview

•	Scene Tab

•	Materials Tab

•	Environments Tab
	 Backplate Overview

	 Backplate Settings

•	Camera Tab

•	Settings Tab
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User Interface > Project Window > Overview

Project Window
The project window can be thought of as the central location for 
making any changes to KeyShot scenes. It is accessed by selecting the 
project button shown on the main toolbar. It can also be accessed by 
pressing spacebar, as well as in the menu bar under window.

If a user needs to duplicate models, delete parts, edit materials, adjust 
lighting, change cameras or anything involving editing, it will be done 
through the project window.
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User Interface > Project Window > Scene Tab

Scene Tab
This will show any models, cameras and animations that you have in 
your scene. Animations can also be added through here.

Models

Models imported from a CAD system will retain any hierarchy that has 
been setup and will be the top item displayed in the scene tree. The 
hierarchy of a model can be expanded by clicking the sign. Any model 
or part that is selected will highlight in the realtime view if this option 
is set in your general preferences. Models or parts can be hidden and 
unhidden by selecting the check. Models or parts can be renamed or 
deleted by right clicking on the part and selecting either option.

Cameras
The currently active camera will be represented by a blue icon. Other 
cameras can be made active by right clicking on the camera and 
selecting ‘set as active camera’ as shown on the left. Cameras can be 
renamed or deleted as well through the right click menu.

Scene Sets
Scene sets allows the user to save the current state of their scene, and 
to choose which camera to save it with. To create a scene set, right 
click  "Scene Sets" in your scene tree and click "Add Scene Set." The 
user can make changes to the scene with the ability to go back to the 
saved scene set by double clicking the scene set, or by right clicking and 
clicking "Make Scene Set Active." The user can also rename and delete 
a scene set via the right click menu.
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User Interface > Project Window > Scene Tab

Scene Tab
Properties
Contains the name of the part, model or camera, and buttons to quickly 
unlink materials and edit the material applied to the part. These actions 
are also available on the right click menu.

Render Layers (Pro)
Allow placement of a model or part on a layer to be rendered. Select/
multi-select the parts/models and select the render layer from the drop 
down. This will apply your selection to the render layer. When rendering 
you will need to enable render layers on the passes output tab.

Rounded Edges
Rounded edges can be applied to any part within your model. This will 
apply a fillet to the part giving it a rounded look. For the best results, 
keep a radius under 1.
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Scene Tab
Position
When a model or part is selected the position tab becomes available. 
This tab contains the move tool, which enables the move tool 
widget. You can also transform the model or part numerically in the 
corresponding fields within this tab.

Materials
The materials tab within the project window is a list of all active 
materials within your scene. This is an invaluable tool as you can link 
similar materials, select parts that have linked materials, or unlink 
materials from parts from this tab. 

User Interface > Project Window > Scene Tab
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Scene Tab
Right Click Menu
Right clicking on items in the scene tree brings up the right click menu 
which has many features not available elsewhere.

Animation
Add an animation to the part selected. Choose from translation, 
rotation, and fade from the flyout.

Material
Link and unlink materials to parts, as well as the ability to change the 
materials type. This is useful at the model if you want to change the 
material globally.

Visibility
Options to show all, show only selected, hide selected, and unhide 
selected. Visibility can also be toggled with the check icon within the 
scene tree panel.

Move
Open the move widget tool on the selected model/part.

Duplicate
Creates a copy of the 3D data in the scene.

Pattern (Model only)
Create instanced copies of your model in pattern formation. Since 
these copies are instanced, patterned geometry will not decrease 
performance or add to file size.

User Interface > Project Window > Scene Tab
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Scene Tab
Look At
Changes the point around the camera centers on.

Delete
Delete the model part from the scene.

Collapse All
Collapses to all root entries in the scene tree

Collapse
Collapse selected to root

Expand
Expand all entries within a model/part

Add to Group
Change where the part is located in the scene tree to better organize 
the 3D data in your scene. WARNING: Changing groups can affect tools 
and effects that are Dependant on existing scene tree structure.

Add to Sub-Group
Move the part to a subgroup within a part. WARNING: Changing groups 
can affect tools and effects that are dependent on existing scene tree 
structure.

User Interface > Project Window > Scene Tab
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User Interface > Project Window > Materials Tab

Materials Tab
When a material is selected the properties are displayed under 
the materials tab in the project window. Selected materials can be 
renamed in the ‘Name’ field and can be saved to the material library by 
click the save material button the “Save to library” button.

Material types can be changed by selecting a type from the ‘Type’ drop 
down menu. All material types contain only the parameters needed to 
create that specific type of material.

Properties
The properties tab will display the properties for the currently selected 
material type. By default only basic properties are shown. If additional 
properties are available, they can be accessed by clicking the button 
next to the basic property.

Textures
Textures such as color maps, specular maps and opacity maps are 
added to the material in this tab. See the section in the manual that 
covers texturing for more specific information.

Labels
Labels can be added to the material in this tab. See the section on the 
manual that covers labeling for more specific information.
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User Interface > Project Window > Environment Tab

Environment Tab
Environment File
Lists the name of the currently loaded environment image. The 
supported formats are .hdr and .hdz (KeyShot proprietary format). 
Clicking the thumbnail opens the HDRI editor (Pro). Click on "Load 
Environment" to open an HDRI or HDZ. Click "Refresh" if changes were 
made to the HDRI externally.

HDRI Settings 
Contrast
Adjust the contrast on the environment which can sharpen and soften 
the shadows. It will also increase the intensity of the light and dark 
areas which can negatively affect the realism of the lighting.

Brightness
Control the amount of light emitted into the scene from the 
environment HDRI.

Size
Control the size of the environment that is lighting the model. This is a 
method of tuning the reflections and lighting in your scene 

Height
Shift the height of the environment up and down which is a method of 
tuning the reflections and lighting in the scene

Rotation
Rotate the Environment for optimal lighting, shadows and reflections.



KeyShot®
   Manual

User Interface > Project Window > Environment Tab

Environment Tab
Background
Lighting Environment

The background will render with the environment used.

Color
Background will be replaced with a solid color. Click the color swatch to 
choose a color.

Backplate Image
Use an Image file for the rendered background. Aspect ratio of render 
window will automatically lock to the aspect ration of the image used. 
This can be turned off in preferences under "General"

Adjust Brightness
Enabling this allows "brightness" and "gamma" adjustments made in 
the settings tab to affect the backplate.

Match Perspective
Align perspective guides to reference points in your backplate for 
accurate camera focal length and twist to match scene with your 
backplates perspective.

Refer to coordinate legend to match coordinate directions.
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User Interface > Project Window > Environment Tab

Environment Tab
Ground Shadows
Enable the ground shadows in the scene. When enabled, there is an 
invisible ground plane that shadows from models are projected on.

Ground Reflections
Reflections of any 3D geometry will be show on the same invisible 
ground plane that ground shadows are projected on.

Shadow color
Click the color swatch to choose a shadow color.

Flatten ground
Flatten the ground of the environment. It is only visible when the 
"lighting environment" is set in the background option listed above.

Ground size
This will increase or decrease the size of the ground plane that shadows 
and reflections are cast on. The best approach is to reduce the ground 
size as much as possible without clipping shadows or reflections.
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Backplates
Backplates are images that can be placed behind a 3D model and used as a background image. This allows a model to be interactively positioned into a 
photo. The lighting is not affected when a backplate is used. If there are transparent materials on the model, the backplate will be visible through them. 
KeyShot comes with matching HDRI and backplate sets. However, you can use any common image file format as a backplate.

User Interface > Project Window > Enviro. Tab > Backplates Overview
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Adjust Brightness
When adjust brightness is enabled in backplate settings in the 
environment tab, the backplate will be affected by the brightness and 
gamma setting in the realtime settings.

Adjust Aspect Ratio to Backplate
Enabling adjust aspect ratio to backplate in preferences will cause the 
realtime view to snap to the same width to height ratio of any backplate 
that is loaded.

Match Perspective
The Match Perspective tool is a quick and easy way to match the 
perspective of your backplate for a seamless integration.

To use, align the arrows along reference points in the backplate. Choose 
2 point perspective for 2 pairs of arrows, or 3 point perspective for 3 
pairs of arrows to match.

Lock Rotation locks the azimuth parameter in your camera settings so 
your model stays at the center of your scene.

The colors of the arrows correspond to the colors of your X, Y and Z 
arrows in your coordinate legend. Use that as your guide as well when 
lining up the arrows with your reference points.

If you want to start over, click reset lines to bring the perspective lines 
back to default.

Match Perspective works best with backplates with parallel lines that 
can be referenced.

User Interface > Project Window > Enviro. Tab > Backplates > Settings
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User Interface > Project Window > Camera Tab

Camera Tab
Cameras in KeyShot have some of the same settings that real world 
cameras have. These can be used to create similar effects that are used 
in photography. In addition, views can be saved and easily viewed to 
help explain features of a design.

Camera List
List of all saved cameras. When the realtime view is moved, the selected 
camera will display the (unsaved) state, and the revert icon will be 
available next to the name field below the list. The user can either click 
the revert icon to return to the last saved state, or click the save icon to 
save the new camera state.

Unlocked/locked buttons
Lock and unlock the currently selected camera. If the camera is locked 
all parameters will be grayed out and cannot be changed.

Add Button 
	 Add Camera
	 Add a new saved camera to your camera list. After making 		
	 changes, click the save icon to save the changes to the camera.

	 Add Viewset (Pro)
	 Viewsets save your camera, environment, and backplate settings.	
	 After making changes, click the save icon to save the changes to 	
	 the viewset.
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User Interface > Project Window > Camera Tab

Camera Tab
Position and Settings
Spherical/Absolute
Spherical settings pertain to the location and angle of the camera in 
relation to the scene. Absolute controls the camera in relation to the 
XYZ coordinates.

Distance (Spherical)
Dolly the camera in and out. The larger the number, the further away 
from the center the camera will be.

Azimuth (Spherical)
Controls the orbit of the camera 360° around the look at point.

Inclination (Spherical)
This will control the vertical inclination of the camera or"elevation", 
allowing cameras to look directly down or directly underneath objects.

Twist (Spherical)
This will twist the camera which will tilt the horizon line and allow the 
creation of "Dutch angles".

Look At Point
 Click and select a point in realtime view to orient around that point. 
Now when camera dolly is used, it will dolly in to that point. "Look at" 
can also be selected, by right clicking a part on the model and selecting 
"look at"
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User Interface > Project Window > Camera Tab

Camera Tab
Position and Settings
View Orientation
Presets for front, back, left, right, top and bottom views. Selecting any 
of these will move the currently selected camera to that position.

Stay Above Ground
Locks the camera to stay above the ground plane.

Lens Settings
Perspective/Orthographic
Perspective mode enables vanishing points and is used for realistic 
renderings. Orthographic removes perspective and is used primarily for 
technical renderings.

Perspective/Focal Length
This will allow different focal lengths to be set the same way they are 
used in actual photography. Lower values simulate wide angle lenses 
and higher values simulate zoom lenses.

Field of View
This will be the cameras angle of view directly in front of it. A wide angle 
lens may have a 180 degree field of view, whereas a zoom lens may 
have a 20 degree field of view.

Ground Grid
Displays a ground grid to help match perspective with a backplate.
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User Interface > Project Window > Camera Tab

Camera Tab
Lens Effects
Depth of Field
This is a technique that is used in photography to help focus a viewer's 
eye where the photographer would like it to go. This is accomplished by 
blurring areas of the image while other areas remain in focus.

Select Point of Focus
This tool automatically finds the focus distance to the where you 
clicked on the model. Simply click the button, and click on your model 
where you would like the scene to stay in focus. Click the check to 
accept the changes

Focus Distance
Manually control where the point of focus will be. Best used as 
refinement of focus distance after using "Select Point of Focus."

F-Stop
Use real world camera settings to adjust the range of what is in focus.

Bloom Intensity
Bloom will add glow around emissive materials and add an overall 
softening to the image. Increase the slider to create a brighter glow.

Bloom Radius
Affects how far a bloom extends from the edges.

Vignetting Strength
Darken the corners and edges of your frame.
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User Interface > Project Window > Settings Tab

Settings
Resolution
Set the resolution dimensions of your realtime render window. Click on 
presets to choose from common sizes used in various media. Enable 
"lock Aspect" to keep the aspect ratio constant when you resize the 
window. Enable "Lock Resolution" to lock and changes to the size of the 
realtime render window.

Adjustments
Brightness
Control the brightness on the rendered image in the realtime view. It is 
applied as a post process (similar to adjusting brightness on an image 
in Photoshop) so the image does not have to be recalculated when 
adjusted as it does when environment brightness is changed.

Gamma
Gamma compensates the way colors are displayed for optimal color 
range for human vision. Lower values will increase contrast and higher 
values will decrease contrast. It is recommended for realistic renders to 
leave this value at the default. It is a very sensitive slider and can cause 
unrealistic results if adjusted too much in either direction.
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User Interface > Project Window > Settings Tab

Settings
Advanced
Performance/Quality Toggle
This toggle switches the realtime render mode from "Performance" 
which renders  faster but at a lower, quality, or "Quality" which renders 
slower but at a higher quality.

Ray Bounces
Increase or decrease the amount of times a ray of light is bounced 
around a scene. It is very important for calculating reflective and 
refractive materials. For more information on ray bounces see the 
section that covers ray bounces in realtime settings.

Shadow Quality
Increase the number of sub-divisions in the ground plane. This will give 
the ground shadow a higher resolution when rendering.

Self Shadows
Controls shadows being able to cast on the model.

Global Illumination
Allows indirect light bouncing between 3D geometry and allows other 
geometry to be illuminated when under transparent materials.

Ground Illumination
Allows indirect light bouncing from 3D geometry onto the ground.
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User Interface > Project Window > Settings Tab

Settings
Advanced
Focused Caustics
This will concentrate the light being shined through an object. A 
common example of a caustics is when light shines through a drinking 
glass, and produces the curved region of bright light.

Render NURBs
NURBS ray-tracing allow the rendering of imported NURBS data within 
KeyShot. NURBS geometry imported from your favorite modeling 
system delivers accurate geometry with smoother edges over data 
imported as polygonal triangles that is made up of and displays straight 
lines on close detail shots. NURBS import is currently available for Creo, 
CATIA, Inventor, SolidWorks, NX, STEP, IGES, Parasolid and ALIAS.

Motion Blur
Enable this to see motion blur effects in your rendering. This effect will 
only be visible with an animation applied to a part of camera within the 
scene.
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User Interface > Render Options

•	Overview

•	Saving Screenshots

•	Output

•	Quality

•	Render Queue

•	Region Render

•	Passes (Pro)

•	Image Editor

•	Export OBJ

•	Publish to GrabCAD
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Rendering and Output
After a scene in KeyShot has been setup, the next 
step is to output either an image or an animation. 
There are multiple methods of accomplishing this. 
In addition, there are different render settings 
that come into play depending on what is being 
rendered. If these values are set too high, they 
can increase render time without any added gain. 
Understanding what the settings are and how to 
tune them will save time when rendering scenes. 
This section will cover these topics.

User Interface > Render Options > Overview
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Saving Screenshots
A screenshot of the realtime view can be saved out at anytime using 
two different methods. The first method is by pressing the "p" key. The 
next method is by pressing the screenshot button found in the main 
toolbar shown in the image below. The screenshots will be saved to 
the renderings folder that is designated in KeyShot resources. Camera 
views can be saved with every screenshot if this option is enabled in 
preferences.

User Interface > Render Options > Screenshots

screenshot button
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User Interface > Render Options > Output

Output
Still Image
Default rendering mode. Enable to render still images.

Animation
This option is only available if there are animations in the scene.

KeyShotVR
This option is only available if there is a KeyShotVR in the scene.

Still Image
Name
Set the file name of the render. If one is not entered, default name will 
be the scene name with in incremental suffix

Folder
Choose where the render will be saved. Unless a specific folder is 
chosen, it will be saved in your KeyShot 5 renders folder

Resolution
Set the resolution of the output render. Type in, or select from presets.

Print Size
If final output is for print quality, enter in the dimensions of the print 
size as well as the desired DPI. After size has been set, the resolution 
will update with the correct dimensions.
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User Interface > Render Options > Output

Image Output - Still Image
Performance
Choose the amount of cores used for rendering. You can either use the 
amount set for your realtime render, or you can set a different amount.

Render Mode
Choose a method to render your image. Default opens the render 
output window and begins rendering immediately. "Background" 
allows you to continue working in KeyShot while the render continues 
in the background. "Add to Queue" allows the user to set multiple 
render jobs and render them at a later time. "Send to Network" is only 
available if you also have "KeyShot Network Rendering installed.

Animation
Resolution
Set the resolution for the animation being rendered. Choose from the 
preset pulldown, or enter in your own custom dimensions.

Time Range
Specify the range of the animation to be rendered. Default is "Entire 
Duration." You can also set the designated work area to be rendered, as 
well a specific frame range. The "duration" and "frames" auto updates 
when time range is changed.
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User Interface > Render Options > Output

Animation
Video Output
Set the name and Folder location where the animation will be saved. 
Choose a file format with the pulldown.

Frame Output
Enable to output every frame used to create the animation. Designate 
the file name and folder where the frames will be saved. Choose a file 
format that the image files will be saved as. If it is a .tif or .png, the 
option to include the alpha channel becomes available.

Performance
Choose the amount of cores used for rendering. You can either use the 
amount set for your realtime render, or you can set a different amount.

Render Mode
Choose a method to render your animation. "Default" opens the render 
output window and begins rendering immediately. "Background" 
allows you to continue working in KeyShot while the render continues 
in the background. "Add to Queue" allows the user to set multiple 
render jobs and render them at a later time. "Send to Network" is only 
available if you also have "KeyShot Network Rendering installed.

Output - KeyShotVR
Review settings set in the KeyShotVR wizard. See section on KeyShot 
VR for a more detailed overview.
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User Interface > Render Options > Quality

•	Advanced Control

•	Maximum Time

•	Maximum Samples
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Advanced Control
Samples
This will control the amount of rays per pixel that will be sent into the 
environment to gather information to determine that pixel's final shade. 
It is best to control this setting per material and set a value between 8 
and 16 in the render settings. For information on samples and setting 
samples per material please see the section on roughness and glossy 
samples.

Ray Bounces
Ray bounces are the number of times rays of light are calculated as 
they bounce around a scene. For a detailed explanation and examples 
please see the section that covers ray bounces in the realtime settings.

Anti Aliasing
Anti aliasing is a method for smoothing out jagged edges that are 
created by pixels. Since pixels are made up of squares, they can 
produce a jagged look where edges meet. Anti aliasing smooths out 
these edges. In most cases the default value of 1 is sufficient.

Shadow Quality
Shadow quality will control the shadow quality for ground shadows. 
This can be tuned in realtime to determine what value is necessary. 
Please see the section on shadow quality found in the realtime settings.

User Interface > Render Options > Quality > Advanced Control
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Advanced Control
Global Illumination Quality
This will control the quality of all indirect light bouncing. Increasing this 
value can dramatically increase render time. It is rarely necessary to set 
a value above the default value of 1. If Global Illumination is turned off, 
this parameter will be grayed out. For more information and examples 
please see the section on detailed indirect illumination in realtime 
settings.

Pixel Blur
This will apply a slight blur to the image to reduce the overly sharp 
look that computer generated images can have. Higher values will have 
more blur. This does not increase render time.

DOF (Depth of Field)
This will control the quality of depth of field if it is enabled in the 
camera tab. Increasing this value will have an effect on render time. 
For production quality work a value between 3 - 5 is recommended. If 
Depth of Field is not activated, this parameter will be grayed out. Please 
see the section on cameras for more information on depth of field.

Caustics
Increasing the value will improve the samples and quality of the 
caustics. If caustics are not enabled, this parameter will be grayed out. 
Please see the section on caustics for more information.

User Interface > Render Options > Quality > Advanced Control
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Advanced Control
Sharp Shadows
This will allow sharp shadows to be cast across 3D geometry when 
the lighting scenario would create a sharp shadow. It is more accurate 
to have this checked and it is enabled by default. It is generally 
recommended to leave this on.

Sharper Texture Filtering
This will attempt to preserve detail in textures when viewed at grazing 
angles. For example, imagine being eye level with a wood table and 
seeing the wood grain compress together. Detail can get lost in the 
compressed areas. This setting reduces the that loss of detail. This 
feature can increase render time so enable only when using textures 
with glancing angles.

Global Illumination Cache
Disabling GI Cache replaces the potential dirty shadows and black spots 
with noise. Increasing GI quality will reduce the noise.

User Interface > Render Options > Quality > Advanced Control
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Maximum Time
The maximum time method of image/animation output will 
progressively refine the render for the amount of time set.

This mode uses the same rendering technique as what you see in the 
realtime view. This technique is also used in maximum samples mode, 
but differs from the method used in advanced control mode.

When rendering an animation, you may set the maximum time for each 
frame to render, or set a total duration for the entire animation.

User Interface > Render Options > Maximum Time
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Maximum Samples
Maximum samples mode controls how many times the image or 
animation frame will be calculated and refined. Each additional sample 
will further smooth out noise/grain in the image.

This mode uses the same rendering technique as what you see in the 
realtime view. This technique is also used in maximum time mode, but 
differs from the method used in advanced control mode.

Samples
This controls how many times each of the pixels in the image being 
rendered will be calculated for further accuracy. Too low of a value here 
will result in an image that has excessive noise. However, be careful 
with increasing this setting too much as there will be a point where you 
will not perceive further benefit, but the image will take far longer to 
render.

Animation
The maximum samples mode is ideal for animation output as it 
guarantees that each frame will have been rendered to the same 
quality. As the animation plays through the frames you will not see 
changes/flickering in shadows or noise patterns on materials.

User Interface > Render Options > Maximum Samples
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Maximum Samples
Tip: Samples and Resolution
A sample calculates the color of a pixel. Although, more samples does 
mean higher accuracy of the color of each pixel in the image, but more 
samples. There is a point of diminishing returns where you can increase 
samples past the point of added quality, and are just increasing the 
render time.

Something important to be aware of is that as you increase the 
resolution of your image or animation, each pixel covers relatively less 
area of the image. This means that you can use a lower samples setting 
when rendering at higher resolutions.

The sample shows the two models rendered with the same samples 
setting. On the right rendering, the resolution was twice that of the left. 
Notice the reduced noise on the right model.

This method is typically preferred over the time based output for 
animations, as some frames may require substantially more time to 
reach the same quality level as levels of detail and complexity change 
through the course of your animation. Using the time based output will 
lead to more noise in the more complicated frames.

User Interface > Render Options > Maximum Samples
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Render Queue
The render queue is used to batch process your still image and 
animation renderings.

Add/Delete Job
Use these buttons to add and remove jobs from the queue list. When 
a job is added, you are recording the exact state of your scene. This 
includes all render settings. Each job, therefore, can have completely 
unique settings.

Move Up/Down
You can select a job in the list, then click move up or down to change 
the order of the list. Jobs at the top render first. You can also multi-
select jobs and move them together.

Other Options
You can use the check boxes next to the job to turn off that job. The job 
will then be skipped during processing of the queue. You can also hover 
your cursor over a job to see an enlarged thumbnail of the image to 
be rendered. When you are ready to start the queue, click the process 
queue button.

Send to Network
If you have KeyShot Network Rendering installed, the option to send to 
send to network will become available.

User Interface > Render Options > Render Queue
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Region Render
The region render option allows you to render a smaller portion of your 
overall image. This is useful when only a small change to one part of a 
scene is needed. Rendering the smaller region saves rendering time.

Enable Region Render
Click the icon to enable, then drag to size the region box in the realtime 
view window or enter specific dimensions and location.

User Interface > Render Options > Region Render
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Render Passes
KeyShot supports different render passes. To enable the pass click the 
checkbox next to the pass you would like to enable. Doing so will render 
the selected pass, along with the original image format specified on the 
output tab.

Depth Pass
Depth pass creates a depth map which is an image that contains 
information relating to the distance of surfaces to the camera. Depth 
maps are used in other applications like Adobe Photoshop and Adobe 
Aftereffects to simulate effects like depth of field

Geometric Normal Pass
Create a normal map image of your scene. See section on normal maps 
in working with textures.

Clown Pass
Clown pass creates an image where individual parts are rendered with 
a flat color. This enables an easy way to create and save selections in 
Photoshop for post rendering work. To use a clown pass, import it to 
the actual image in Photoshop. This creates another layer. Use the color  
range tool to select each of the colors in the clown pass and create a 
mask for each group.

Render Layers
This option is only available if you have assigned parts and models to 
a render layer. This option will render each render layer with only the 
parts/models assigned to it. 

*NOTE* enabling render layers will render all render layers created.

User Interface > Render Options > Passes (Pro)

Depth Pass

Normal Pass

Clown Pass
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User Interface > Render Options > Image Editor

Image Editor
The image editor is a post process utility that allow you to make tweaks 
to your render while it is rendering. Click the pencil icon to open the 
image editor on the render output window.

Close Render
Click this to close the render output window. CAUTION: all adjustments 
made in the image editor will be lost. Be sure to save your render after 
making adjustments before closing the render  output window.

Save
Saves the current state of the render. Be sure to save after completing 
adjustments in the image editor to save changes.

Gamma
Gamma compensates the way colors are displayed for optimal color 
range for human vision. Lower values will increase contrast and higher 
values will decrease contrast.

Brightness
Control the brightness on the rendered image.

Saturation
Increase or decrease the color intensity in the render

Hue
Shift the colors in the render. This can be a quick way to create multiple 
color studies from a single render.

Effects
See section on effects in the Settings Tab section for more information.
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Export to OBJ
KeyShot supports exporting your 3D data from KeyShot into an *.obj 
file type. All individual parts and material groups will be maintained 
on export. Animations will not be exported, only supports geometry 
export.

User Interface > Render Options > Export to OBJ (Pro)
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Publish to Grab CAD
Publish to GrabCad will allow you to easily upload your rendering 
straight from KeyShot 4.1 to GrabCad. To do so, Under "File" in the 
menu bar, click "Publish to GrabCad". You will first need to authenticate 
your GrabCad account before you can upload.

User Interface > Render Options > Publish to GrabCAD
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Importing and Working With Data

•	Supported Types

•	Importing

•	Model Units

•	Navigating Your Scene

•	Hiding/Showing Parts

•	Regrouping Parts

•	Scene Tree

•	Multi-Selection

•	Duplicating Models

•	Pattern Tool

•	Moving Models and Parts

•	Live Linking
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Importing and Working With Data > Supported File Types

•	 ALIAS 2013 and prior(needs to be installed)

•	 AutoCAD(DWG/DXF)

•	 CATIA v5

•	 Creo 2 and prior

•	 Inventor 2013 and prior

•	 Maya 2013 and prior(needs to be licensed)

•	 NX 8 and prior

•	 Pro/ENGINEER Wildfire 2 -5

•	 Rhinoceros 5 and prior

•	 SketchUp 8 and prior

•	 Solid Edge ST5 and prior

•	 SolidWorks 2013 and prior

•	 IGES

•	 JT

•	 STEP AP203/214

•	 OBJ

•	 Parasolid

•	 FBX

•	 3DS

•	 Collada
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Importing and Working With Data > Importing Models

Importing Models
Supported file types can be imported into the KeyShot interface by 
pressing the import button from the main toolbar.

Files can also be imported by dragging and dropping them into the 
interface, or by selecting 'File -> Import' from the top menu. When a file 
is designated for import, the import window will be displayed on the 
screen.

Center Geometry
When checked, 'Center Geometry' will import the model and place it in 
the very center of the environment. Any original 3d coordinates for the 
model are removed when center geometry is selected. If this option is 
not selected, the model will be placed in the same position in 3D space 
that it was originally created.

Snap to Ground
When checked, 'Snap to Ground' will import the model and position 
it directly on the ground plane. This will also remove any original 3d 
coordinate information.

Orientation
Not all modeling applications define the up axis in the same manner. 
Depending on your application, you may need to set a different 
orientation other than the default "Y Up" setting. If your model is 
coming in on its side, try setting a different orientation.

Toolbar

Import Window
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Importing and Working With Data > Importing Models

Importing
Adjust Camera to Look at Geometry
When checked, upon import the camera will center fit to the imported 
geometry in the scene.

Adjust Environment to Fit Geometry
When checked KeyShot will perform the calculation to fit the 
environment proportional to the geometry imported into the scene.

Use Material Template
If you have a saved material template, you can apply the template to 
the imported geometry. Use the pulldown menu to choose the saved 
material template you would like to use.

Import NURBS Data
When importing a model that contains NURBS geometry, enable this 
check to include the NURBS geometry in the scene.
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Importing and Working With Data > Importing Models

Importing
Second Import
The import dialogue parameters change slightly when a model is 
already loaded in a scene.

Add to Scene
When checked, this will add your model to the existing scene.

New Geometry
When checked, this will replace the geometry with the new imported 
geometry.

Update Geometry
With this checked the newly added geometry will update the existing 
geometry, if part names match. Replacing the old geometry.

Size - Automatic
This will automatically scale the imported model to the scene.

Size - From Previous Import
This feature is useful if you have already assigned materials to 
your model, but decide to make a change to your geometry. When 
you re-import your updated model, any assigned materials will be 
automatically reassigned on parts that have kept their original name. 
Retain Materials
This feature is useful if you have already assigned materials to 
your model, but decide to make a change to your geometry. When 
you re-import your updated model, any assigned materials will be 
automatically reassigned on parts that have kept their original name.
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Importing and Working With Data > Model Units

Model Units
The scale of models, the distance between models, the intensity of 
local lights, and the mapping scale of textured materials are all relative 
to the unit of measure: millimeters, centimeters, meters, inches, feet, 
etc. In KeyShot, these units of measure are introduced as the model 
units of the scene. Model units are listed under the scene information 
window.

Set units upon import: With every new scene, the first import will 
define the model units for the scene. Selecting an "Automatic" size 
upon import will apply the system default unit: None. When "Keep 
Original" size is enabled the magnitude and unit of the model, as 
established in the modeling software, is read and applied to the scene. 
Any subsequent imports will be scaled in relation to the set model units 
as long as "Keep Original" size is enabled.

Changing the Model Units: To change the model units, go to Edit > Set 
Model Units and make your selection. Note that changing the model 
units will NOT re-size the models in the scene. Instead, changing the 
model units via the Edit menu affect the scale of the environment, 
ground plane and in turn affect the physical lights and the mapping 
scale of certain textured materials.
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Importing and Working With Data > Navigating Your Scene

Navigating Your Scene
Tumbling Your Camera
To tumble your camera, press and hold the left mouse button while 
moving the mouse

Panning Your Camera
To pan your camera press and hold the middle mouse button while 
moving your mouse

Dollying Your Camera In and Out
To dolly your camera press the alt key (windows) or the option key 
(mac) plus the right mouse button while moving the mouse.

Tumble Camera
Left Mouse Button + Drag

Pan Camera
Middle Mouse Button + Drag

Dolly Camera
ALT(WIN)/OPTION(MAC) + Right Mouse Button
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Importing and Working With Data > Hiding/Showing Parts

Hiding Parts
In some cases materials may need to be assigned to parts that are 
enclosed in other pieces of geometry. To hide parts, right click on the 
part and select 'hide part'. A single part of a model can be shown by 
right clicking on a part and selecting 'show only this part'. Parts can 
also be hidden using the scene tree.

Showing Parts
To display a hidden part right click in the interface and select 'undo 
hide part'. To bring back all previously hidden parts select 'show all 
parts'. Parts can also be shown using the scene tree.
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Importing and Working With Data > Regrouping Parts

Regrouping Parts
Regrouping gives you the ability to organize the scene tree. Adding a 
group is done by right-clicking on the top level and selecting "Add to 
group" or "Add sub-group". Parts and sub-assemblies can be drag and 
dropped to new groups in the scene tree.

Note* Reordering parts and sub-assemblies will break live-linking and 
update geometry.
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Importing and Working With Data > Scene Tree

Scene Tree
The scene tree displays models and their hierarchies along with any 
cameras that exist in a scene. Animations are also represented in the 
scene tree in versions of the software that include the animation add 
on. Models and parts can be hidden and shown using the check box 
next to the name. The check box displayed next to animations can be 
used to disable and re-enable animations that are applied.

Collapsing the scene tree hierarchy can be very useful if your model 
has a lot of parts. This can be achieved by right-clicking the section you 
would like to collapse and select "collapse". The full hierarchy is able to 
be collapsed also, by selecting "collapse all".
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Importing and Working With Data > Multi-Selection

Multi-Selection
Multi-select multiple objects in the realtime window using box-
selection. Hold down SHIFT + left mouse button to activate box-
selection. Objects will only be highlighted when the scene tab is open, 
Object Highlight is enabled in Preferences by default.

Multi-selecting can also be achieve by holding SHIFT and selecting the 
models/parts in the scene tab.
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Importing and Working With Data > Duplicating Models

Duplicating Models
Models and parts can be duplicated by right clicking on them in the 
scene tree and selecting 'duplicate'. This action duplicates the model 
along with any assigned materials and animations.
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Importing and Working With Data > Pattern Tool

Pattern Tool
Right click a model on the scene tree, and select "Pattern" to open 
the pattern tool panel. The pattern tool creates instances instead of 
duplicates of model data to increase speed, and decrease model size.

Linear/Circular
Create patterns in a linear or circular formation.

Instances (Linear)
Set how many instances area created along the X, Y, and Z axis.

Count (Circular)
Set how many instances are arrayed around an axis.

Spacing (Linear)
Set the spacing of the instances for X, Y, and Z.

Radius (Circular)
Distance from instances to center or pattern axis.

Fill Angle (Circular)
The angle at which to array the instances from. 360 is a full circle.

Rotate Objects
Instances can be rotated along the Y of each local access to dynamically 
position them in the scene.

Center
Centers the pattern to the scene.

Resize Environment
Automatically increase environment size to accommodate all instances.
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Importing and Working With Data > Moving Models and Parts

Moving and Parts Models
Models and Parts can be moved by right clicking on the model or part 
and selecting move object. This will pull up the move widget. Highlight 
the different handles and click and drag to translate, rotate, and scale 
in the X, Y, and Z directions.

"Snap to Ground" quickly moves the model in the y direction so as to 
be tangent to the ground plane. This is useful when the model has been 
transformed and is not longer touching the ground plane.

Choose an axis from where to reference your transforms from. Local 
uses the axis inherent in the part or model, while global uses the XYZ 
coordinates from the KeyShot scene.

To snap in 15 degree increments, hold shift as you drag a rotate handle.

To save your transforms, click the green check. To undo all 
transformations, click the red X and the model will revert to the state 
before starting the move tool.
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Importing and Working With Data > Live Linking

Live linking for Creo, Solidworks & Rhino
Live linking allows seamless model updates between the CAD software 
and KeyShot, without having to reassign materials or update settings. 
You will need to download the live linking plugin from our website

Live linking will need to be enabled in Preferences > Advanced.
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Working With Materials

•	Accessing the Library

•	Assigning Materials

•	In Project Library

•	Copying and Pasting Materials

•	Editing Materials

•	Saving Materials

•	Material Templates

•	Color Library

•	Color Picker
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Working With Materials > Accessing the Library

Accessing The Library
The library can be accessed by clicking the library button in the main 
toolbar or hot key 'M'. That will pull up the library window shown. From 
there, any material, color, environment, backplate and texture available 
in the KeyShot resources folders will be loaded. This is also where your 
favorites are stored under the favorites tab..
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Working With Materials > Assigning Materials

Assigning Materials
Materials can be assigned to models by dragging and dropping from 
the library onto a part in the realtime window. This will show a preview 
of what parts that material will be assigned to. The material will not be 
assigned until the user lets go of the left mouse button.

Once the material has been loaded from the library, a copy will be 
placed into the in project library. Any additional materials assigned 
to the model will also be added to the in project library. If the same 
material already exists in the in project library, a copy will be created 
and a number will be appended to that material.

In some cases a user may want to have one material assigned to 
multiple parts, be able to make changes to that material, and have it 
affect all parts. To do this, the same material should be assigned from 
the in project library to those multiple parts. Since that is the same 
material from the in project library, any edits made to that material will 
affect all parts that it is assigned to. Another method of accomplishing 
this is by copying and pasting the material from one part to another.

Retaining Textures and Labels
If you are dragging a material onto a part that has an existing texture 
or label, you can retain them and apply them to the new material by 
holding ALT for textures, or CTRL for labels.
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Working With Materials > In Project Library

In Project Library
The in project library is found in the lower half scene tab under 
materials. When a material is pulled from the material library and 
assigned to a model, a copy of that material is placed in the "in project 
library". All materials will be represented in the form of material ball 
thumbnails, or a list view.

This window will show all materials that are active within a scene. If a 
material is no longer being used in the scene it will be automatically 
removed from the in project library. For example, if a material is 
assigned to only 1 part, and a new material is assigned on that part, the 
previous material will be removed from the in project library since it is 
no longer used in the scene.
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Working With Materials > Copying and Pasting Materials

Copying and Pasting Materials
There are two methods of copying and pasting materials. The most 
important concept to understand when copying and pasting is that 
when a material is copied from one part to another, any future edits to 
that material will affect both parts.

The first method is by pressing "shift + left click" on a material assigned 
to a model. That will copy the material. Next, to paste the material, 
press "shift + right click" on another part. That will copy the same 
material from the in project library and paste it to another part. Now, 
any edits made to that material will affect both parts.

The second method is by dragging and dropping a material from the 
in project library onto a part that does not already have that material 
assigned.

SHIFT + LEFT CLICK		 -	 Copy Material

SHIFT + RIGHT CLICK	 -	 Paste Material
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Working With Materials > Editing Materials

Editing Materials
There are multiple methods of navigating to the material properties to 
make changes, but all editing is done through the materials tab found 
in the project window.

The first method of accessing the material properties is by double 
clicking a part on a model in the realtime view. That will pull up the 
material properties for the material assigned to that part.

The second method of accessing material properties is by double 
clicking a material thumbnail in the in project library.

The third method of accessing material properties is by right clicking a 
part in the scene tree and selecting 'edit material'.

The forth method of accessing material properties is by selecting the 
part in the scene tree. In the second pane selecting "Edit material".

All material edits made will update interactively in the realtime view. 
For more detailed information on material settings and types please 
see the section of the manual that covers material types and their 
settings.
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Working With Materials > Saving Materials

Saving Materials
There are two methods of saving materials.

The first method of saving is by right clicking a material on the model 
and selecting "add material to library".

The second method of saving is by clicking the "Save to library" shown 
in the material properties.

Once a user has gone through either step, a dialogue will prompt them 
to designate which folder in library hierarchy they would like to save to.

Once the folder location has been selected, the new material will be 
saved to the library.
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Working With Materials > Material Templates

Material Templates
Material templates automate the material application process. 
Materials from the KeyShot library are applied to parts based on the 
name of the part's original materials.

The material template menu is found within the "Window" menu bar.

Create/Delete Templates
Create a new template by clicking on the add icon below the templates 
list. Two methods can be used in creating a material template: 
"Automatic" and "Manual".

Automatic-If a model is in KeyShot when creating a new template, the 
source and material names are automatically populated based on the 
material applications in the current scene.

Manual-An empty template is created and the user can add template 
items manually.

Each new template is added to the template list which can be accessed 
with any scene opened in KeyShot.
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Working With Materials > Material Templates

Material Templates
Template Items
A template item consists of a source name and material name.

Use the " + " button to create a new item.

Click an item to select the item from list and edit the source and 
destination name. You may also change the source type.

Use the to delete a selected item.

Source Type
The source type can be "Part" or "Material". The part type considers 
the part names in the scene. The material type considers the material 
names in the scene.

Source Name
Depending on the source type, the source name is the name of the 
part or the name given to the default material applied to parts of 
your models. The naming of your default materials is controlled in the 
modeling software.

Destination Name
The destination name is the name of the material from the KeyShot 
library that is to be applied to all parts that match the source name. 
When editing the destination name, you can type the name or drag and 
drop a material from the library into the templates menu.
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Working With Materials > Material Templates

Material Templates
Applying Templates
Applying templates can be done through the material templates dialog 
or the import dialog.

	 Material Template Dialog
	 Templates can be applied using the "Apply" button. This will give 	
	 you two options: "To Scene" or "To Selection".

		  To Scene
		  Apply the current template to the entire model.
		  To Selection
		  Apply the current template to the selected model or part.

	 Import Dialog
	 Click the "Materials" accordion to reveal the "use material 		
	 template" checkbox. Enable this setting and select the desired	
	 template from the list. Click "Import" to complete the import.

Wild-Card Assignment
The wild card refers to the source name assigning to a certain 
destination. This can be activated by inserting an asterisk (*) to the 
source name (e.g. *Inner*) this will apply the material in the destination 
to all the parts containing "inner", upon applying the material template.
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Working With Materials > Color Library

Color Library
KeyShot color library lets you drag and drop predefined colors onto any 
part or object inside the realtime window.

PANTONE® and RAL® color libraries are included for use.

Searching for colors can be done by clicking in the search box in the 
top right, and typing the name of the color. This will search the entire 
selected folder, for the specific color.

Searching can also be achieved by selecting the crosshair in the top 
right of the dialog. This will prompt a dialog with a color picker where 
you are able to select the color you are looking for.

Color libraries can also be imported from a *.csv file by using the import 
button, and browsing to the file.

You can create colors manually within KeyShot by right-clicking inside 
the color library and selecting "Add Color".
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Working With Materials > Color picker

Color Picker
The Color picker can be accessed anytime a color box is clicked, as 
well as the eyedropper tool in the color library. The color picker gives 
you the ability to test and view your colors visually, or by numerically 
entering in specific values. The color picker supports rectangular and 
triangular color map representations.

The color picker supports the following color formats:

RGB

CMYK

HSV

Grayscale

CIE-L*ab

Kelvin

Swatch colors can be drag and dropped from the top color bars (both 
new and old), to the bottom squares. This will set the color in the 
square. Swatches can be overwritten by simply dragging and dropping 
new colors on existing ones.

The eye dropper icon gives you the ability to select any color on your 
display, and the color picker will update with the selected color from 
the eye dropper.

To save colors to your library, click the save icon which will prompt you 
to pick a folder to save your chosen color.
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Textures

•	Overview

•	Texture Mapping

•	Interactive Mapping Tool

•	Texture Settings

•	Color Maps

•	Specular Maps

•	Bump Maps

•	Opacity Maps

•	Procedural

•	Labels
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Textures > Overview

Texturing Overview
Texturing allows images to be mapped to materials to create the 
detailed effects such as wood grain, meshes, tile and fine imperfections 
such as brushed metals. Textures are applied in the material properties 
under the texture tab. Textures can be easily drag and dropped 
from a mapping type to another.(e.g. bump -> specular) Simple hold 
Ctrl(Windows) or Command(OS X) and drag the texture.
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Texturing Mapping
Texture mapping is a way to take 2D images and place them onto 
3D objects. This is a common problem that all 3D applications must 
address in some way. For example, does it place it from the top? On 
the bottom? From the side? The examples below cover the methods 
KeyShot has for addressing texture mapping.

Planar X
This will project a texture on the X axis only. Surfaces of 3D models that 
are not oriented on the X axis will show stretching in the texture like in 
the image shown.

Planar Y
This will project a texture on the Y axis only. Surfaces of 3D models that 
are not oriented on the Y axis will show stretching in the texture like in 
the image shown.

Textures > Texture Mapping

Planar X

Planar Y
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Texturing Mapping
Planar Z

This will project a texture on the Z axis only. Surfaces of 3D models that 
are not oriented on the Z axis will show stretching in the texture like in 
the image shown.

Box Map
This will project a texture from six sides of a cube in towards a 3D 
model. A texture will be projected from a side of the cube until 
stretching occurs, then the next best projection side will take over. 
Box mapping is a quick and easy solution that will work in most cases 
because there will be minimal stretching of textures.

Textures > Texture Mapping

Planar Z

Box Map
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Texturing Mapping
Spherical
This will project a texture inwards from a sphere. The texture will 
resemble the original image the most at the equator. The texture will 
start to converge as it reaches the poles of the sphere. As with box 
mapping, stretching is less of an issue when working on multi sided 
objects than it is with any of the planar mapping modes.

Cylindrical
The example below illustrates how a 2D texture is projected on a 3D 
model when the mapping mode is set to "Cylindrical mapping". The 
texture will project the best on surfaces that are facing the inside of the 
cylinder. The texture on surfaces that do not face the inner walls of the 
sphere will stretch inwards.

Textures > Texture Mapping

Spherical Map

Cylindrical Map
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Textures > Texture Mapping

Texturing Mapping
UV Coordinates
This is a completely different method of applying 2D textures to 3D 
models, in that it is an entirely custom made. It is more time consuming 
and is much more widely used in the entertainment industry as 
opposed to the design/engineering world.

Interactive Mapping Tool
In addition to the automatic mapping modes shown above, KeyShot 
has an interactive mapping tool that will allow, scaling, translating and 
orienting any of the automatic mapping types interactively.

UV Coordinates



KeyShot®
   Manual

Textures > Interactive Mapping Tool

Interactive Mapping Tool
The interactive mapping tool is used to fine tune the position of 
textures as they are mapped to your model. The tool is accessed from 
the texture mapping tab within the material editing menu, and is 
available when in box, spherical and cylindrical mapping modes. 

Translate
Use arrow handles to move the texture mapping position on the XYZ 
axes. To translate the mapping click on any of the three axis arrows. The 
red, green and blue arrows correspond to the X, Y, and Z axes.

Rotate
Use circle handles to rotate and align the texture mapping to your 
model. Hold shift to constrain the rotation to 15 degree increments.

Scale
Use cube handles to change the size of the texture mapping. Click on 
red, green, or blue boxes to scale the texture on only one axis, Or, click 
on the center yellow box to scale the texture uniformly.

Position
Use position to establish exactly where you want the center of your 
texture image to project. Once in position mode you can simply click on 
the surface of the model to change the where your texture is projecting.

Cancel or Confirm Changes
After adjusting the texture mapping with the mapping tool, click the 
green check mark to confirm the changes and close the mapping tool. 
Click the red X to cancel the changes and close the mapping tool.
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Textures > Texture Settings

Texture Settings
Scale
Change the scale of the image file. This can be done uniformly or on the 
X or Y axis.

Shift X/Y
Use shift to nudge textures incrementally to apply textures exactly 
where you need them to be.

Angle
The Angle slider will control the textures mapping angle. The slider 
supports both negative and positive values.

Brightness
Adjust the brightness of the image file.

Contrast
Adjust the contrast of the image file.

Sync
When using multiple maps in conjunction Sync allows the settings for 
each map to match. This allows the maps to align properly.

Repeat
When enabled the image file used for the texture will be tiled and 
repeated along the surface. When unchecked, the image fill will only 
appear once.

Flip Horizontal/Vertical
If the image file you are using needs to be mirrored use these toggles to 
flip the image on the correct axis. 
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Textures > Color Maps

Color Maps
Color maps use photographs to replace the basic solid diffuse color. 
This is used to recreate realistic digital materials based on photographs 
of real world materials Any common image format can be mapped to 
material types that have the color map available. The example shows a 
wood texture mapped to the color texture on the advanced material. 
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Textures > Specular Maps

Specular Maps
Specular maps can use black and white values to indicate areas that 
have varying levels of specular intensity. Black will indicate areas of 
0%specular reflectivity, whereas white will indicate areas of 100% 
specular reflectivity. Notice on the example that the metal portions are 
reflective and emitting specular reflections, whereas the rust area does 
not. The rust area has black mapped to it, whereas the metal area has 
white. See the texture for reference.
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Textures > Bump Maps

Bump Maps
Bump maps are used to create fine details in materials that would be 
unrealistic to include in the model, like the hammered chrome and 
brushed nickel in the example. There are two different methods of 
creating bump maps. The first and easiest way is by applying a black 
and white image. The second way is by applying a normal map.

Black and White Values
In a black and white bump map, the black values are interpreted is 
lower and the white values are interpreted as raised. You can see how 
this interpreted in the example.

Normal Maps
A normal map was used to create the hammered chrome in the 
example shown. Normal maps contain more colors than the standard 
black and white bump maps. These additional colors represent 
different levels of distortion on X, Y and Z coordinates. This can create 
more complex bump effects than a black and white bump map which 
has only 2 dimensions. However, most bump effects can and will look 
very realistic without the need for normal maps. Enable the effect by 
checking "Normal Map" in the bump map settings.

Bump Height
In bump maps, brightness and contrast has been replaced with bump 
height. Increasing this raised the peaks of the bumps, and helps 
exaggerate the bump when the texture needs to be more visible.

Bump Map Normal Map
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Textures > Opacity Maps

Opacity Maps
Opacity maps can use black and white values or alpha channels 
to make areas of a material transparent. This is useful for creating 
materials like the mesh material shown, without actually modeling the 
holes.

Opacity Mode
The opacity mode can be set to 3 different methods: 

	 Alpha - this will use any alpha channel that is embedded in the 	
	 image to create the transparency. If no alpha channel is present, 	
	 no transparency will be shown.

	 Color - this will interpret black areas as completely transparent 	
	 and white areas as completely opaque. 50% gray will be 50% 	
	 transparent. This method is available to avoid the need for alpha 	
	 channels.

	 Inverse Color - inverse color is the opposite of color. White will 	
	 be completely transparent, black will be completely opaque and 	
	 50% gray will be 50% transparent.
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Textures > Procedural > Overview

Procedural Overview
Procedural textures are customizable textures that allow you to 
control the grain and color of the texture in realtime. In comparison 
to traditional texture mapping, procedural textures wrap around your 
model without leaving seams or stretching, regardless of the model's 
shape.

KeyShot 4 comes with six commonly used procedural texture types: 
Granite, Leather, Marble, Noise (Texture), Noise (Fractal), and Wood. You 
can select your texture type via the Texture Type pull down found inside 
the texture mapping tab within the material editing menu.
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Textures > Procedural > Brushed

Brushed
The brushed procedural texture simulates the effects of brushed metal. 
Best used as a bump on a metal material with low roughness value.

Bump Height
Set the depth of the brushed texture

Length
Control the length of the brush strokes.

Contrast
Controls how defined the brush stokes are.
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Textures > Procedural > Cellular

Cellular
The cellular procedural texture is an advanced tool to create a wide 
variety of texture maps. You can create a hammered texture as seen 
here, or you can create cracked surfaces, orange peel paint, crumpled 
paper, and more.

Scale
Set the scale of the scale of the texture

Bump Height
Control the overall intensity of the texture map

Contrast
Contrast refers the to the difference in the peaks and valleys of the 
bump map. Control them globally, or expand for finer controls.

Shape
Control the fractal shapes generated with this slider, and the sliders 
contained within.

Levels
Increase or decrease the levels of fractals being generated.

Noise
Add noise to the line quality of the fractal shapes
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Textures > Procedural > Cloth Weave

Cloth Weave
Cloth Weave simulates many types of fabrics and fine woven materials.

Gap Color
This will designate the color in between the woven colors.

U/V Thread Colors
Assign the colors of your threads to affect the overall color of the 
weave.

U/V Width
Controls the thickness of the threads.

UV Wave
Changes the direction of the threads within the weave to simulate 
different types of woven patterns.

Contrast
Increase or decrease the contrast of the threads.

Width Noise
Controls the uniformity of the thread widths.

Color Noise
Controls the uniformity of the thread colors.

Distortion Noise
Controls the uniformity of the thread straightness.
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Textures > Procedural > Color Gradient

Color Gradient
The Color Gradient Procedural Texture allows you to mix 2 seperate 
colors on a surface, without having to create a custom texture map.

Mapping Tool
Use this to move the center line of the gradient.

Color 1
Choose the first color of the gradient

Color 2
Choose the second color of the gradient.

Scale
Adjsut the scale to have a large or small blend across the surface.

Location 1
Adjust the location of where color 1 starts on the gradient.

Location 2
Adjust the location of where color 2 starts on the gradient.

Gradient Type
Choose from linear, spherical, and cylindrical to match the shape of 
your part or model you are applying the gradient to.
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Textures > Procedural > Fiber Weave

Fiber Weave
Fiber Weave simulates many types of thicker woven material like 
carbon fiber meshes.

Color 1
This is the gap color.

Color 2
This is the color of the woven material.

Projection
Choose the type of projection used.

Scale
Set the correct scale of the weave in relation to the model.

Gap
Controls the size of the gap between the weaves.

Edge Width
Increasing this creates deeper shadows within the weave

Contrast
Increase or decrease the contrast of the threads.

Fibers
Set the amount of threads seen within the fibers.

Noise
Add noise to the weave color.

Weave Noise
Add noise to the straightness of the weave.
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Textures > Procedural > Scratches

Scratches
Scratches is great way to add weathering to a material, in particular, 
metal materials.

Scale
Set the correct scale of the pattern generated.

Bump Height
Increase to have deeper scratches.

Density
Controls the amount of scratches generated.

Size
Set the size of the individual scratches. Expand to control scratch width, 
and scratch falloff.

Directional Noise
Controls the randomness of the direction of the scratches. Decrease to 
have scratches in a more aligned direction. Expand to choose mapping.

Noise
Controls the straightness of the scratches. Increase to have more 
irregular shaped scratches. Expand to access the noise scale slider.

Levels
Controls the amount of unique scratches are generated. Expand to 
access the level scale.
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Textures > Procedural > Granite

Granite
The granite procedural texture allows you to simulate the granite on a 
counter top, tile, or stone.

Color
This is the overall color of your granite texture

Scale
This controls the scale of the grain in the granite.



KeyShot®
   Manual

Textures > Procedural > Leather

Leather
The leather procedural texture allows you to easily replicate a leather 
textured material.

Color 1
This is the color of the high points (bumps) in leather. This color should 
be lighter than color 2, but it should be as close to color 2 as possible 
for realistic looking leather.

Color 2
This is the color of the low points in leather. This color should be darker 
than color 1, but it should be as close to color 1 as possible for realistic 
looking leather.

Scale
This controls the scale of the leather grain.

It is highly suggested to add a synced procedural leather bump to 
further simulate realistic leather.
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Textures > Procedural > Marble

Marble
The marble procedural texture allows you to simulate the marble 
material on a counter top, tile, or stone.

Color 1
This is the overall color of your granite texture.

Color 2
This is the color of the veins in granite.

Vein Thickness
This allows you to adjust the thickness of the veins in granite.

Vein Noise
This adds random fluctuations in the granite veins.

Vein Noise Scale
This adds fluctuations to the overall direction of the granite veins.

Scale
This controls the scale of the veins in granite.
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Textures > Procedural > Noise (Texture)

Noise (Texture)
The noise (texture) procedural texture is very similar to the stock noise 
texture in the textures library and it allows you to simulate ripples in 
glass and liquid materials when used as bump.

Color 1 and 2
The noise procedural has light and dark colors that you can modify 
using these two settings.

Scale
This controls the scale of the noise.

Magnitude
This increases the intensity of color 2 and contrast between the two 
colors.
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Textures > Procedural > Noise (Fractal)

Noise (Fractal)
The noise (fractal) procedural texture also allows you to simulate 
ripples and bumps in your material.

Color 1 and 2
The noise procedural has light and dark colors that you can modify 
using these two settings.

Levels
This adds more detail to the fractal noise.

Fall-off
This controls the color balance. Low values accentuate Color 2, and high 
values accentuate Color 1.

Scale
This controls the scale of the fractal noise.
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Textures > Procedural > Wood

Wood
The wood procedural texture allows to customize the look of your wood 
materials. Most often you will want to start out with the plastic material 
type and change the specular color to white.

Ring Width
This adjusts the thickness of the wood ring.

Ring Noise
This adds random fluctuations in each ring.

Axial Noise
This adds fluctuations or waviness of the overall direction of the grain.

Color Noise
This creates random thicks and thins to give a more organic look to the 
wood ring.

Scale
Increase size of the grain. For best results keep a small scale.
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Textures > Labels > Overview

Labels
Labels are designed for easy placement of logos, stickers or images that 
need to be placed freely onto a 3D model. Labels are added through the 
labels tab in a material's properties.

Any common image format will be supported such as .jpg, tiff, tga, .png, 
.exr and .hdr. An unlimited number of labels can be added to a material 
and each label can have it's own mapping type. If an image has an 
alpha channel embedded, it will be retained and areas of transparency 
will not show. The image below uses a PNG with transparency so that 
the square border of the image does not show.
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Textures > Labels > Label Management

Label Management
Adding Labels
Labels are added by either clicking the Add Icon or the Folder Icon or 
by double clicking the empty image swatch next to the labels list. Once 
added, the label name will be displayed in the list. If a label has been 
updated outside of KeyShot, it can be refreshed by clicking Refresh 
Icon.

Deleting Labels
Labels can be deleted by selecting the label in the list and clicking the 
Trash Icon

Duplicating Labels
Labels can be duplicated by selecting the label in the list and clicking 
the Add Icon, and select duplicate.

Layering
Labels will be layered as they are added. The label at the top of the 
list will be the top label in the layers. The label order can be shifted by 
pressing the up and down arrow buttons. 
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Textures > Labels > Label Mapping

Label Mapping
Labels can be mapped using the same mapping types as other textures 
but labels have a mapping type that textures do not. This mapping type 
is Normal Projection. This allows labels to be projected on surfaces 
interactively - even across curved surfaces. Normal projection is the 
default method that will be set when a label is added.

To position the label, click the mapping tool button and then click on 
the model to move the label. When the label is in the desired position,

Confirm the placement by clicking the 'done' button in the bottom of 
the realtime window. That will deactivate the interactive positioning.

To scale the label, move the scale slider. This will adjust the size of 
the label and maintain height to width proportions. To scale the 
label vertically or horizontally, expand the scale parameter to scale 
independently on the X or Y axis.

To rotate the label, use the angle slider which will rotate the label in 
degrees.

Labels can also be flipped vertically, horizontally and repeated by 
checking any of those options.
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Textures > Labels > Label Properties

Label Properties
Intensity
Intensity can be thought of as a brightness adjustment. If the overall 
lighting of a scene is good, but a label appears too bright or dark then 
the intensity slider can be used to adjust this.

Contrast
Controls the amount of contrast in the label image.

Depth
This will control how far a label is projected through a material.

Specular
The specular parameter will allow specular reflections to be calculated 
on the label. Click below for an example and more information. 

Refraction Index
Index of refraction. Although this property is most commonly 
associated with transparency, it can be used on labels to increase the 
level of reflectivity. It will only affect the label if the label specular color 
has a value other than black.

Two sided
The two sided parameter will control whether or not a label is visible 
from the back. Click the thumbnail below to see an example.
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Overview
The main source of lighting in KeyShot is through environment images. 
These are 32 bit images designed to map to the inside of a sphere. 
When the KeyShot camera is inside this sphere, it can be pointed in any 
direction to see a fully enclosed environment. This method makes the 
creation of photo realistic lighting as simple as dragging and dropping a 
thumbnail into the realtime view.

KeyShot ships with several different environment types broken into 
categories. Some are real world photo environments and others are 
studio environments. The photo environments are usually best suited 
for automotive or entertainment, whereas the studios are usually best 
suited for product and engineering. Either one will produce unique and 
realistic results regardless of what is being rendered.

The image is a view where the camera has been pulled back to show a 
3D model enclosed in an environment. The environment is mapped to 
the inside of the environment sphere.

Adjusting Lighting > Overview
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Changing Environments
All lighting is determined by the currently loaded environment. 
To change an environment, simply drag and drop one from the 
environment library into the realtime view. When the left mouse button 
is released the new environment lighting will be loaded and the lighting 
of the model will be updated.

Adjusting Lighting > Changing Environments
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Adjusting Contrast
The contrast of the environment lighting can be adjusted by using the 
contrast slider This will change the contrast between light and dark 
areas in the environment lighting. Less contrast will soften shadows 
and more contrast will sharpen them.

Adjusting this value too much can have a negative effect on the realism 
of the rendered image. It is recommended to leave this at the default 
value for that reason.

Adjusting Brightness
There are multiple methods of adjusting the brightness of the lighting 
within a scene. Regardless of the method, all changes will be shown 
instantly in the realtime view.

The first method is by using the arrow keys on the keyboard. Up and 
Down arrows will increase or decrease the environment brightness in 
large increments. The Left and Right arrows will increase or decrease 
the brightness in smaller increments.

The second method adjusting brightness is by using the brightness 
slider in the environment tab of the project window.

Adjusting Lighting > Adjusting Brightness and Contrast
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Controlling Lighting Directions and Reflections
Although the environment lighting that ships with KeyShot is preset, 
there are quite a few adjustments that can be made to change the look.

Rotate
The first and easiest method is by pressing "control + left click + drag 
left or right" in the realtime view. This will rotate the environment and 
change the value of the rotation property found in the environment tab 
in the project window. The two images below show the same camera 
view with the same materials and environment. The only difference is 
the environment rotation. KeyShot can determine the brightest light 
sources in an environment and will calculate shadows accordingly.

Height
The next method of controlling lighting and reflections is by adjusting 
the height slider found in environment tab in the project window. This 
will shift the environment sphere up and down and will also change 
how lighting and reflections affect the model.

Size
Another method of controlling the lighting is by adjusting the size of the 
environment sphere by adjusting the size slider found in environment 
tab in the project window.

Adjusting Lighting > Controlling Lighting Directions and Reflections
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Background Color
Any background color can be set by choosing the color option from the 
environment tab in the project window. When 'color' is selected, the 
environment will no longer be shown behind the model. This will have 
no effect on the lighting of the model and will only serve as a backdrop. 
However if there are any transparent materials in the scene, the 
background color will show through them. To change the background 
color, click on the color box.

Adjusting Lighting > Background Color
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Ground Shadows and Reflections
Ground shadows and reflections can be enabled under the environment 
tab in the project window

Ground Shadows
Enable to show ground shadows on ground plane. Default and 
suggested color of shadows are black, but can be changed to suit 
special situations where the shadow color needs to be changed.

Ground Reflections
Enable to show a reflection of the scene on the ground plane.

Flatten Ground
Pulls the Environment to a flat ground instead of projected on the 
sphere. Turn this setting on only for specific usages.

Ground Size
Ground shadows and ground reflections are projected onto an invisible 
ground plane. The size of the ground plane can affect the quality of 
shadows and whether or not shadows and/or reflections become 
clipped. The ground size can be adjusted by using the ground size slider 
in the environment tab in the project window. This setting should be set 
as small as possible without clipping the ground shadows or reflections.

Adjusting Lighting > Ground Shadows and Reflections
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Ground Shadows and Reflections
A good way to understand the ground shadow is to compare it to digital 
images composed of individual pixels. When an image is scaled up and 
individual pixels can be distinguished, the image loses clarity. When the 
image is scaled down, the pixels condense together and a clear image is 
produced.

The ground plane works in a similar manner. It is composed of grid 
squares that are shaded at different intensities to produce the ground 
shadow. If the ground plane is 128 by 128 squares and a model sits on 
top of only 8 squares, there is not very much resolution to work with 
and a shadow can appear blocky. By reducing the ground size, more 
squares are packed into a smaller area which will improve the ground 
resolution and the look of the ground shadow. This is why lower ground 
size values are better.

Adjusting Lighting > Ground Shadows and Reflections

The ground size is large and the cube sits on 
top of a small amount of grid squares. This 
makes the shadow appear blocky.

The ground size has been reduced too much 
and the shadow becomes clipped.

The ground size has been reduced which 
condenses the grid squares into a smaller 
area. The shadow has more resolution and is 
rendered higher quality.
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Physical Lights
Physical Lights are essentially working as materials that are being 
applied to parts and objects. Any geometry can be turned into a light 
source. You can either import new geometry, or use existing geometry 
to turn into a light source.

Applying a Light
Applying a light material is similar to applying materials. Light materials 
will be displayed in the material type drop down. Select the light source 
type, and KeyShot will update the object to a physical light. Light 
sources can be easily found in the scene tree represented by a light 
bulb icon.

Moving Lights
Right-click the object/part that is assigned as a light and select "Move 
Model". This will activate the move tool widget.

You can also select the light source in the scene tab, in the second pan 
select the position tab. You can activate the move tool widget from 
there, or use the input boxes for a more precise positioning.

Adjusting Lighting > Physical Lights > Overview
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Physical Lights
Point Light Diffuse
Applying a point Light Diffuse to geometry replaces it with a point 
located at the parts center. 

Color
Choose the color the light will cast. For accurate lighting colors, use the 
Kelvin scale to select accurate lighting temperatures.

Power
The power of the light can be controlled by either Watts or Lumen.

Radius
Adjust the radius to control the falloff from shadows cast from this light.

Adjusting Lighting > Physical Lights > Point Light Diffuse
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Physical Lights
Point Light IES Profile
When switching the material to IES light you will need to load an IES 
profile by clicking on the folder icon in the editor. As soon as you load 
the profile you will see the shape of the IES profile in the material 
preview. You will also see the shape in form of a mesh in the realtime 
window.

File
Displays the name and location of the IES profile being used. Click the 
folder icon to change to a different IES profile.

Color
Choose the color the light will cast. For accurate lighting colors, use the 
Kelvin scale to select accurate lighting temperatures.

Multiplier
Adjust the intensity of the light with this slider.

Radius
Adjust the radius to control the falloff from shadows cast from this light.

Adjusting Lighting > Physical Lights > Point Light IES Profile
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Physical Lights
Area Light Diffuse
Area light diffuse will give you a wide range of light dispersion. This will 
function similarly to a flood light. Power can be controlled in either 
Watts or Lumen.

Color
Choose the color the light will cast. For accurate lighting colors, use the 
Kelvin scale to select accurate lighting temperatures.

Power
The power of the light can be controlled by either Watts or Lumen.

Apply to Front of Geometry
Apply the light source to the front of the  surface geometry.

Apply to Back of Geometry
Apply the light source to the backside of the surface geometry.

Visible to Camera
Toggle the light source geometry from being  shown in the realtime.

Visible in Reflections
Toggle the light source geometry from being seen in a reflection.

Visible in Shadows
Toggle the light source geometry from casting a shadow in the scene.

Adjusting Lighting > Physical Lights > Area Light Diffuse
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Overview
The realtime settings are found in the project window under the 
settings tab. The settings here will have the greatest effect on the 
performance of realtime rendering as well as the look of the rendering 
in the realtime view.

Realtime Settings > Overview
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Setting Resolution
Resolution
The resolution for the realtime view is set in the project window under 
the settings tab. Use the Preset pulldown to select commonly used 
dimensions.

Lock Aspect
When this option is checked the width to height ratio of the realtime 
view will be maintained when values are typed in the resolution box, or 
when the realtime view is scaled by grabbing the edges of the window 
with the mouse and scaling up or down.

Lock Resolution
This will lock the current resolution, and disable the rescaling of the 
realtime render window.

Realtime Settings > Setting Resolution
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Brightness
Adjusting the brightness in the realtime tab is a post process applied to 
the image rendered in the realtime view. Since it is a post process the 
image does not need to be recalculated when this value is adjusted, 
unless a backplate is loaded.

Gamma
Adjusting this value applies a gamma correction to the rendered image 
as a post process. Again, since this is a post process the image does not 
need to be recalculated.

Gamma correction is a method for displaying colors in the most 
efficient way for human vision. Without gamma correction colors can 
be displayed in ranges that the human eye could not differentiate 
between.

It can also be thought of as a form of contrast. Lower values will add 
additional contrast and higher values will decrease contrast.

This is a sensitive setting and can cause unrealistic results very easily if 
adjusted too much in either direction. For the most realistic renders, it 
is recommended to leave this at close to default value.

Realtime Settings > Brightness and Gamma
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Quality Mode
This is the default mode for KeyShot and will have the best image 
quality for the realtime render. This mode favors the quality of the 
image over the performance and speed of your computer.

Performance Mode
Performance mode lowers the realtime render settings to achieve the 
fastest performance and speed. The upper right corner of the realtime 
view will show this icon to indicate performance mode is active.

Quickly toggle between Quality Mode and Performance Mode by 
pushing ALT + P.

Realtime Settings > Quality Modes
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Ray Bounces
Ray bounces are a setting that allow a certain number of rays to be 
bounced around a scene. In the real world, light rays bounce infinitely, 
but in the rendering world limits need to be set since everything 
needs to be calculated. Bounces occur when something is reflected or 
refracted. For example, when two mirrors are facing each other, light 
is bounced back and forth generating reflections. When light enters a 
diamond, the light is slowed down and refracted and reflected back 
and forth on the facets which creates the look of a diamond. Light will 
refract any time it passes through a transparent material.

Because of the light bouncing that occurs with reflection and refraction, 
it is important to have enough bounces to render those types of 
materials correctly. Sound complicated? Fortunately KeyShot makes it 
easy. The bounces can be set in realtime and for every bounce that is 
added or taken away, the realtime view will update and show you the 
result. If no visual improvement is noticed in the scene when adding a 
bounce, that means no further bounces are necessary.

The types of objects that will be important for ray bounces are 
headlight enclosures, diamonds and anything that is reflective or 
transparent. Those are the areas that should be focused on when 
determining how many bounces to use.

Realtime Settings > Ray Bounces
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Ray Bounces
Reflections
The examples show reflections rendered at different bounces to help 
show the effect that different ray bounce numbers have. When more 
bounces are needed it will be apparent because areas will be black 
where light has stopped calculating.

Realtime Settings > Ray Bounces

1 Ray Bounce 2 Ray Bounces

8 Ray Bounces 32 Ray Bounces

Two mirrors facing each other
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Ray Bounces
Refractions
The examples show refractions rendered at different bounces to help 
show the effect that different ray bounce numbers have. When more 
bounces are needed it will be apparent because areas will be black 
where light has stopped calculating.

Realtime Settings > Ray Bounces

3 Ray Bounces 6 Ray Bounces

11 Ray Bounces 32 Ray Bounces

1 Ray Bounce
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Shadow Quality
Refractions
To fully understand the shadow quality setting please see the section 
that talks about the ground plane. This setting will increase or decrease 
the amount of subdivisions in the ground plane and will produce a 
higher quality ground shadow, but it will take more processing power. If 
a ground shadow appears blocky, increasing this value can improve this 
but it is recommended to reduce the ground size as much as possible 
before resorting to shadow quality.

Realtime Settings > Shadow Quality

Higher shadow quality

Lower shadow quality
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Detailed Shadows
Detailed shadows include any shadowing that is rendered in the 
realtime view. The option to turn this off is included to improve 
performance while setting up a scene.

Realtime Settings > Detailed Shadows

Detailed Shadows Off

Detailed Shadows On
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Global Illumination
When this setting is off, there will not be any indirect light bouncing 
between 3D geometry. In addition, geometry that is under transparent 
materials will render dark since light is not allowed to bounce through 
the transparent material and illuminate the object underneath.

Realtime Settings > Global Illumination

Global Illumination Off

Global Illumination Off

Global Illumination On

Global Illumination On
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Ground illumination
This is the same setting and function as detailed indirect illumination 
but it is specific to the ground plane.

Realtime Settings > Ground Illumination

Global Illumination Off

Global Illumination Off

Global Illumination On

Global Illumination On
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Effects
Bloom
The bloom feature will soften the entire image and help add glow to 
emissive materials. The intensity will increase the power of this effect. 
The radius will control how far out the bloom will extend from the 
edges of objects. For a subtle effect, try setting a low intensity with a 
high radius. If the slider range does not allow the desired value, a higher 
value can be manually typed in.

Vignetting
The vignetting effect will darken the edges of the rendered image to 
help bring the focus towards the center of the image.

Realtime Settings > Effects
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Overview
KeyShot material types have been designed to be easy to use with as 
few parameters as possible for a given material type. For example, 
metals will have only the parameters needed to create a metal and 
plastic will have only the parameters necessary to creates plastic. 
The following sections will cover all of the material types and their 
parameters.

The first four sections cover some common parameters that are 
found throughout several material types. Since KeyShot is designed 
to be able to create realistic materials with little to no experience, an 
understanding of these concepts is not necessary, but can help gain a 
deeper understanding of how rendering and material creation works. 
These properties are: diffuse, specular, refraction index and roughness 
(glossy).

Material Types and Their Settings > Overview
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•	Diffuse Parameter

•	Specular Parameter

•	Reflection Index

•	Roughness Parameter

Materials > General Parameters
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Diffuse Parameter
The diffuse parameter will be found throughout many of the material 
types. The most basic way to think of diffuse when working in KeyShot 
is a material's overall color. However, there is a more technical 
explanation of what this is that can help when creating materials:

The word diffuse means "to-scatter" or "spread out". Diffuse in the 
rendering world refers to how light reflects off of materials. Depending 
on the surface of a material, light rays will behave differently when they 
hit the surface. If a surface has little or no imperfections like a polished 
surface, light rays will bounce straight off. This will produce a shiny or 
reflective surface. If the surface has many imperfections like concrete 
light rays will be scattered across the surface creating a matte look. 
This is why concrete is not reflective or shiny.

The diffuse parameter will control the color of the diffuse rays (left 
diagram) on a material.

Material Types and Their Settings > Diffuse Parameter
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Specular Parameter
The specular parameter is another parameter that will be found on 
many material types. Specular reflections are reflections that are 
bounced off a material surface without scattering. Materials appear 
reflective or shiny when a surface is polished and has little to no 
imperfections. When the specular color is set to black, a material will 
have no specular reflections and will not appear reflective or shiny. 
Specular color set to white will give 100% reflectivity for that material. 
Metals do not have diffuse color so any color will be derived entirely 
from the specular color. Plastics can only have white as the specular 
color.

The specular parameter will control the color and intensity of the 
specular light reflections on a material.

Material Types and Their Settings > Specular Parameter
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Refraction Index
Refraction index is another material parameter that will be found 
on multiple KeyShot material types. The term might not be familiar, 
but refraction is something that is commonly seen every day. A good 
example is when a person sticks their hand in a pool. The light is bent, 
or "refracted" and the arm looks broken.

Refraction occurs because light travels through different mediums at 
different speeds. This reduction in speed is referred to as a material's 
refraction index and is represented by a number. For example, water 
has an index of refraction of 1.33, glass has an index of refraction of 1.5 
and diamonds have an index of refraction of 2.4. This means that light 
travels through water 1.33 times slower than it does through a vacuum. 
Light travels through glass 1.5 times slower, through diamonds 2.4 
times slower and so on. The slower light travels, the more it is bent and 
distorted.

Refraction indexes for different materials can be easily found Online. 
Once the value is found, it can be entered into the refraction index 
property of a material, and it will be accurately represented in KeyShot.

Material Types and Their Settings > Refraction Index
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Roughness Parameter (Glossy)
The roughness parameter is another setting that will be found on 
multiple material types in KeyShot. This is a slider that will add 
microscopic levels of imperfections to the surface to create rough 
materials. The diagram that explains diffuse can also help explain 
why materials appear rough. When roughness is added, light rays are 
scattered across the surface which causes specular reflections to break 
up. Due to the additional light scattering, rough materials are more 
challenging and take more processing power to render than perfectly 
reflective surfaces.

Glossy Samples
Since rough (glossy) materials are more complex to render, KeyShot 
has a setting built into materials that can improve the accuracy of these 
rough materials. This setting is called glossy samples. The samples 
refer to the number of rays that are shot out from a pixel in a rendered 
image. Each ray collects information from it's surrounding environment 
and returns this information back to the pixel to determine it's final 
shade.

Material Types and Their Settings > Roughness Parameter (Glossy)
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Advanced
The advanced material is the most versatile of all KeyShot material 
types. There are more parameters in this material than any other. 
With the variety of parameters, materials such as metals, plastic, 
transparent or cloudy plastics, glass, diffuse and leathers can all be 
created from this single material type. Material types that cannot be 
created are translucent materials and metallic paints.

Diffuse
This can be thought of as the overall color of the material. Transparent 
materials will have little or no diffuse. Metals will have no diffuse with 
all the color derived from the specular.

To fully understand this parameter see the section on diffuse.

Specular
This is the color and intensity of the reflection of light sources 
within the scene. Black will be 0 intensity and the material will not 
be reflective. White will be 100% intensity and will be completely 
reflective. If a metal material is being created, this is where the color is 
set. If a plastic material is being created, the specular color should be 
white or gray to reduce reflectivity. Plastics will not have color in the 
specular. 

To fully understand this parameter see the section on specular.

Material Types and Their Settings > Advanced

Texture Maps Available

Color Specular Bump Opacity

Yes Yes Yes Yes
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Advanced
Specular Transmission
This can be thought of as the transparency of the material. Black will be 
100% opaque and white will be 100% transparent.

If a transparent glass or plastic is being created, the diffuse should 
be black with all the color derived from this parameter. Transparent 
glasses or plastics should also have the specular set to white. If a cloudy 
plastic is desired, the diffuse can be set to a very dark version of the 
color set here.

Diffuse Transmission
This will cause additional light scattering across the surface of the 
material which can simulate a translucent effect. It will increase render 
time, so if it is not needed the recommendation is to leave it at black.

Ambient
This will control the color of self shadowing on the material in areas 
that are not receiving direct light. It can produce unrealistic looks, so it 
is recommended to keep this set to black unless it is needed.

Roughness
This will add microscopic levels of imperfections to the surface of the 
material when the values are increased. When set to 0, a material will 
appear perfectly smooth and polished. When the value is increased the 
material will appear more rough as light is diffused across the surface.

Material Types and Their Settings > Advanced

Roughness

Ambient

Diffuse Transmission
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Advanced
Roughness Transmission
This will control the roughness of the refractions. The main difference 
between this parameter and roughness is that the roughness is on the 
internal portion of the material. This can be used to create a frosted 
look while still maintaining a shiny surface. The material needs to have 
some transparency through the specular transmission to see any affect.

Refraction Index
This will control the level of refraction on the material.

Fresnel (pronounced frah-nel)
This will control the intensity of the reflections that are perpendicular 
to the camera. In the real world, materials are more reflective around 
the edges of objects than they are on areas of objects that are directly 
facing the viewer or camera. It is enabled by default because in it is the 
accurate setting. Different materials have different Fresnel falloff.

Glossy Samples
This will control the accuracy of glossy (rough) reflections.

Material Types and Their Settings > Advanced

Fresnel

Refraction Index

Roughness Transmission
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Anisotropic
The anisotropic material type gives you advanced control over the 
highlights on the material surface. On other material types that have a 
single "roughness" slider, as you increase this value the highlights on 
the surface spread out evenly in all directions. Anisotropic gives you 
control over the highlight shape by controlling the roughness in two 
directions with two independent sliders. This material type is often 
used to simulate a finely brushed metal surface.

Diffuse
To fully understand this parameter see the section on diffuse.

When trying to create a metal the diffuse should be set to black. When 
set to anything other than pure black, this material type will take on 
more a plastic look.

Specular
To fully understand this parameter see the section on specular.

This is the color and intensity of the reflection of light sources 
within the scene. Black will be 0 intensity and the material will not 
be reflective. White will be 100% intensity and will be completely 
reflective.

If a metal material is being created, this is where the color is set. If a 
plastic material is being created, the specular color should be white or 
gray to reduce reflectivity. Plastics will not have color in the specular.

Material Types and Their Settings > Anisotropic

Texture Maps Available

Color Specular Bump Opacity

Yes Yes Yes Yes
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Anisotropic
Roughness X and Y
These sliders control the spread of the highlights on the surface. The 
X and Y roughness sliders control the highlight spread in independent 
directions.

As you offset the values the highlights on the surface will stretch out 
and give a finely brushed effect.

Setting both sliders to the same value will yield reflections that are 
spread evenly in all directions.

In the image below, the ball on the left has offset values and the right 
has equal values.

Angle
This rotates the stretched highlights that are produced when the 
roughness x and y values are offset. The value is in degrees and goes 
from 0 to 360.

Material Types and Their Settings > Anisotropic

Roughness X and Y

Angle
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Anisotropic
Mode
This advanced setting controls how the highlights are stretched. There 
are three unique modes.

The default mode is 1 which will stretch highlights in a linear way, and 
is independent of any UV coordinate mapping you may have on the 
model.

Mode 0 is dependent on your UV coordinates. You can use this to 
manipulate the anisotropic highlights based on the mapping from your 
modeling software.

Mode 2 is a radial anisotropic method which simulates the effect you 
might observe on the play side of a CD.

Samples
To fully understand this parameter see the section on samples. A low 
samples setting (8 or lower) will tend to make the surface look more 
noisy which will give a more imperfect and rough look. As you increase 
the value the noise will even out more and provide a more evenly 
distributed roughness.

Material Types and Their Settings > Anisotropic

Samples
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Dielectric
The dielectric material type is a more advanced way to create glass 
materials. Compared to the solid glass material type, you will find 
additional settings for dispersion (Abbe number) and it can also be 
used to create an accurate interface between glass and liquid.

Transmission
This option controls the overall color of this material type. When light 
enters the surface it will take on the color set here. The amount of color 
that you see in this material is highly dependent on the "color density" 
setting as well. If you have set a color in the transmission, but it looks 
too faint, skip down to the color density section.

Refractive Index
This slider controls how much light will bend or "refract" as it passes 
through parts on your model that have this type of material. The 
default of 1.5 is accurate for simulating most types of glass, but you 
can increase the value to create a more dramatic refraction within the 
surface.

Material Types and Their Settings > Dielectric

Texture Maps Available

Color Specular Bump Opacity

No No Yes Yes
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Dielectric
Transmission Out
This option controls the color of the light on the outside of the material. 
It is an advanced and complex setting, but is needed when rendering 
containers with liquid. In the example of a water glass, you will need to 
have a dedicated surface for where the liquid and glass meet. On this 
surface, you set the color of the glass with the transmission outsetting 
then you can control the color of the liquid with the transmission. If the 
glass and liquid are both clear, set both transmission and transmission 
out to white.

Refractive Index Outside
This slider is an advanced, but powerful, setting that allows you to 
accurately simulate the interface between two different refracting 
materials. The most common use for this is when you are working on a 
container with liquid inside, like a water glass. In such a scene you will 
need a single surface to represent where the glass and water meet. On 
this surface you have the liquid on the "inside" and therefore set the 
refractive index to 1.33. On the "outside" you have the glass and should 
set the refractive index outside to 1.5.

Material Types and Their Settings > Dielectric

Refractive Index Outside
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Dielectric
Color Density
This slider controls how much of the color you have set in the 
transmission property you will see depending on how thick the part is 
that the material is applied to.

This physically accurate parameter simulates the effect you can 
observe by looking at the color of the shallow water at a beach versus 
the deep blue of a deep ocean. Without color density you would see 
through to the bottom of the deepest ocean as easily as the bottom of a 
swimming pool.

After setting a color in the transmission setting, use the color density 
setting to make that color more or less saturated and prominent. A 
lower setting will show the color more in thin areas of the model, and a 
high setting will make the color faint in the thin areas.

Roughness
Roughness on this type of material will spread out highlights on the 
surface similar to what you see on other, non-transparent, materials. 
However, it also spreads out the light that is transmitted through the 
material.

This is used to create a frosted glass look.

Expand this parameter and you will see a samples setting. This can be 
used with a low setting to produce a more imperfect/noisy result or a 
higher value to smooth out the noise/grain for a smoother frosted look.

Material Types and Their Settings > Dielectric

Color Density

Roughness
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Dielectric
Abbe Number (Dispersion)
The Abbe number slider controls dispersion of light as it is transmitted 
through the surface and produces a prismatic effect.

This prismatic color effect can be used to create the "fire" effect often 
desired when rendering gem stones.

A value of zero will disable the dispersion effect entirely. A low value will 
show heavy dispersion, and as you increase the value, the effect will get 
more subtle. A setting around 35-55 is a good starting point if a subtle 
dispersion effect is desired.

Expand this parameter and you will see a samples setting. This can be 
used with a low setting to produce a more imperfect/noisy result or a 
higher value to smooth out the noise/grain for a smoother look.

Material Types and Their Settings > Dielectric

Abbe Number (Dispersion)
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Diffuse
The diffuse material has only one parameter and that is the diffuse 
color. It will be useful for easily creating any kind of matte, or non-
reflective material. Since it is an entirely diffuse material, specular maps 
are not available on the diffuse material.

Diffuse
This parameter will control the color of the diffuse material. To fully 
understand this parameter see the section on diffuse.

Material Types and Their Settings > Diffuse

Texture Maps Available

Color Specular Bump Opacity

Yes Yes Yes Yes
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Emissive
Emissives can be used for small light sources such as LEDs, lamps or 
even illuminated screen displays. It is not meant to illuminate scenes 
as a main light source. The emissive material will need detailed indirect 
illumination enabled in realtime settings to illuminate other geometry 
in the realtime view. It will also need ground indirect illumination to 
illuminate the ground plane as shown below. Color textures can be 
mapped to the material and any colors included in the texture will 
be emitted as light. When using emissives, it is a good idea to enable 
bloom under effects in realtime settings. This will create the glowing 
effect shown in the image.

Color
This will control the color of the light emitted from the material

Intensity
This will control the intensity of the light that is emitted.

Visible to Camera

Hide the emissive material from the camera but it will still emit light.

Visible in Reflections
Hide the emissive material from any specular reflections. The effect of 
the emissive will only be seen on the diffuse component of materials

Two-Sided
This will display on both side of the model

Use Color Map Alpha
This will allow you to use the alpha channel on the color map

Material Types and Their Settings > Emissive

Texture Maps Available

Color Specular Bump Opacity

Yes No No Yes
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Flat
The flat material is a very simple material type that produces an 
unshaded, perfectly even, color over the entire part that it is applied.

This material is often used as a "black out" material behind car grills or 
other meshes. It is also useful for creating a "clown pass" image which 
has uniquely colored flat materials applied to each part of the model 
so that these solid colors can be used to easily create selections in an 
image editing software.

Color
Click the color thumbnail to launch the color picker to select the color 
of the material. The flat material has no shading or other surface 
properties. It will show the solid color you have selected over the entire 
part that the material is applied to.

Material Types and Their Settings > Flat

Texture Maps Available

Color Specular Bump Opacity

Yes No No Yes
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Gem
The gem material is related to the solid glass, dielectric, and liquid 
material types. The settings have been optimized to be relevant to 
rendering gem stones.

The Abbe number (dispersion) control is especially important for gem 
stone rendering as it produces the "fire" effect that is often desired.

The internal culling setting is another specialty of this material type.

Color
This controls the overall color of this material type. When light enters 
the surface it will take on the color set here.

The amount of color that you see in this material is highly dependent on 
the transparency setting as well. If you have set a color, but it looks too 
faint, skip down to the transparency section.

Refractive Index
This controls how much light will bend or "refract" as it passes through 
parts on your model that have this type of material.

The default of 1.5 is accurate for simulating most types of glass, but you 
can increase the value to create a more dramatic refraction within the 
surface. Most gem stones have a higher refractive index than 1.5.

Material Types and Their Settings > Gem

Texture Maps Available

Color Specular Bump Opacity

No No Yes Yes
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Gem
Transparency
This setting controls how much of the color you have set in the 
transmission property you will see depending on how thick the part is 
that the material is applied to.

After setting a color in the transmission setting, use the transparency 
setting to make that color more or less saturated and prominent. A 
lower setting will show the color more in thin areas of the model, and a 
high setting will make the color faint in the thin areas.

Roughness
Roughness on this type of material will spread out highlights on the 
surface similar to what you see on other, non-transparent, materials. 
However, it also spreads out the light that is transmitted through the 
material.

This is used to create a frosted glass look. 

Expand this parameter and you will see a samples setting. This can be 
used with a low setting to produce a more imperfect/noisy result or a 
higher value to smooth out the noise/grain for a smoother frosted look.

Material Types and Their Settings > Gem

Transparency
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Gem
Abbe Number (Dispersion)
The Abbe number controls dispersion of light as it is transmitted 
through the surface and produces a prismatic effect. This prismatic 
color effect can be used to create the "fire" effect often desired when 
rendering gem stones.

A value of zero will disable the dispersion effect entirely. A low value will 
show heavy dispersion, and as you increase the value, the effect will get 
more subtle. A setting around 35-55 is a good starting point if a subtle 
dispersion effect is desired.

Expand this parameter and you will see a samples setting. This can be 
used with a low setting to produce a more imperfect/noisy result or a 
higher value to smooth out the noise/grain for a smoother look.

Material Types and Their Settings > Gem

Abbe Number
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Glass
This is a simplified material type for creating glass materials.

Compared to the solid glass material, you will notice this material 
type lacks the roughness and color density settings. However, it adds 
the two sided option which is very useful when you have a part that is 
just a single surface (no thickness) and you want to make it reflective 
and transparent, but not refractive. This is a commonly used for car 
windshields.

Color
Sets the overall color of the glass material. Click the color thumbnail to 
open the color picker then select your desired color. Refractive Index 
This controls how much light will bend or "refract" as it passes through 
parts on your model that have this type of material.

The default of 1.5 is accurate for simulating most types of glass, but you 
can increase the value to create a more dramatic refraction within the 
surface.

Two-Sided
This enables or disable the refractive property of the material. When 
enabled, the material will appear refractive. When disabled, the 
material will not be refractive. You will see reflections on the surface 
and the surface will be transparent, but light will not bend as it passes 
through the surface. Disabling this option is very useful when you want 
to see things that lay behind a surface without the distorted effect that 
results from refraction.

Material Types and Their Settings > Glass

Texture Maps Available

Color Specular Bump Opacity

No No Yes Yes
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Ground
This is a simplified material type for creating ground material.

Simply click "Edit" and select "Add ground plane". This will add a 
ground plane into your KeyShot scene. The ground material can also be 
applied to imported geometry.

Shadow Color
The shadow that is being casted from the object will be displayed in this 
color. Clicking the color block will allow you to edit the color.

Specular
The ground material supports specular parameter. Please refer to 
specular for more information.

Clip geometry below ground
If any geometry is being displayed below the ground plane material. 
The option will clip the geometry below the ground plane, hiding it 
from the camera.

Refraction Index
This controls how much light will bend or "refract" as it passes through 
the ground material surface.

The default of 1.5 is accurate for simulating most types of glass, but you 
can increase the value to create a more dramatic refraction within the 
surface.

Material Types and Their Settings > Ground
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Leather
The leather material utilizes an automatically generated bump texture 
to create leather-like bumps on surfaces without any need for mapping 
texture images.

It is a powerful material type that can be used for effects other than 
strictly leather materials. Using a very fine scale on the texture and a 
high reflectivity you can create rough plastic and even metal looking 
materials.

Color 1 and 2
The automatically generated leather bump texture has hills and valleys 
and you can use the separate color 1 and 2 settings for offsetting the 
color of these hill and valleys.

Using highly contrasting values will result in an unnatural result, so 
generally you will want to set the two colors to the same or very similar 
values.

Color 1 sets the color of the high points of the leather bumps and color 
2 sets the color of the low points.

Reflectivity
This controls the intensity of the reflection on the surface. A high value 
will make the leather shine and a value of zero will make the material 
purely diffuse.

Material Types and Their Settings > Leather

Texture Maps Available

Color Specular Bump Opacity

No No Yes Yes
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Leather
Roughness
Roughness on a leather material makes a more or less polished looking 
material. However, it is possible that with a very small scale setting 
and too high of a height setting your material can look rough when the 
roughness setting is at zero. This is because the roughness does not 
affect the prominence of the automatic leather bump texture.

A low value will look more like a polished leather and a high value will 
look more matte and also helps a leather surface look soft. A samples 
setting is available within the roughness parameter. This controls 
overall perfection of the spread out highlights on the surface. A low 
setting will look imperfect/noisy and a high value will smooth out this 
noise/grain.

Height
This controls the intensity of the bumps in the automatically generated 
leather bump texture. A high value will make the surface look rough/
rugged leather while a low value will look more fine and smooth.

Scale
This controls the size of the leather bumps in the automatically 
generated leather texture. A smaller value actually results in larger 
scale leather bumps which produces a more rugged looking leather, 
which a higher value will makes the bumps in the leather smaller and 
more fine looking.

Material Types and Their Settings > Leather

Roughness
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Liquid
The liquid material type is a variant of the solid glass material that has 
the added ability to set the outside refractive index. This allows you 
to accurately create surfaces that represent the interface between, for 
example, a glass container and water.

However, for more advanced liquid in container scenes (if colored liquid 
is required) you will want to use the dielectric material type.

Color
This controls the overall color of this material type. When light enters 
the surface it will take on the color set here.

The amount of color that you see in this material is highly dependent on 
the transparency setting as well. If you have set a color, but it looks too 
faint, skip down to the transparency section.

Refractive Index
This controls how much light will bend or "refract" as it passes through 
parts on your model that have this type of material.

Material Types and Their Settings > Liquid

Texture Maps Available

Color Specular Bump Opacity

No No Yes Yes
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Liquid
Refractive Index Outside
This is an advanced, but powerful, setting that allows you to accurately 
simulate the interface between two different refracting materials. The 
most common use for this is when you are working on a container with 
liquid inside, like a water glass. In such a scene you will need a single 
surface to represent where the glass and water meet. On this surface 
you have the liquid on the "inside" and therefor set the refractive 
index to 1.33. On the "outside" you have the glass and should set the 
refractive index outside to 1.5.

Transparency
This setting controls how much of the color you have set in the 
transmission property you will see depending on how thick the part is 
that the material is applied to.

After setting a color in the transmission setting, use the transparency 
setting to make that color more or less saturated and prominent. A 
lower setting will show the color more in thin areas of the model, and a 
high setting will make the color faint in the thin areas.

Material Types and Their Settings > Liquid

Refractive index Outside
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Metallic Paint
The metallic paint material type simulates a three layer paint job. You 
start with a base layer, then can control how much metal "flake" you 
want, then on top of it all is a clear-coat that provides a clean reflection 
over the entire paint.

Base Color
This is the overall color of the material and can be consider the base 
coat of paint.

Metal Color
This can be thought of as a coat of metal "flakes" sprayed over the base 
coat. You can choose a color that is similar to base color to get a subtle 
metal flake effect, or you can choose a contrasting color to get some 
interesting results. A white or gray metal color is also commonly used 
for realistic paints.

The metal color in the material will show more in the directly lit or 
brightly highlighted areas of the surface while the base color will show 
more in the less illuminated areas.

Material Types and Their Settings > Metallic Paint

Texture Maps Available

Color Specular Bump Opacity

Yes Yes Yes Yes
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Metallic Paint
Metal Coverage
This controls ratio of base color to metal color. When set to 0 you will 
see only the base color. When set to 1 the surface will be almost entirely 
covered in the metal color.

For most metallic paint materials you will want this set closer to 0. A 
setting of 0.2 is a good starting point.

Metal Roughness
This controls the spread of the metal color over the surface. When set 
to a low value you will see the metal color in only small areas around 
highlight. When set higher the metal will spread more evenly across the 
entire surface.

0.1 is a good starting point. Within the metal roughness parameter you 
will find a samples setting. This will control how imperfect or refined 
the metal effect in the paint will look. A low setting will result in a more

Noticeable "flake" effect. A higher setting will smooth out the 
distribution of the metal effect and will have less noise/grain. When 
seeking a pearl effect, a higher setting is preferred.

Material Types and Their Settings > Metallic Paint

Metal Color
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Metallic Paint
Clear-Coat Roughness
The top "layer" of the metallic paint material is a clear-coat that, by 
default, provides perfectly clean reflections. However, if a satin or 
matte paint effect is desired the clear-coat roughness value can be 
increased. This will spread out the reflections on the surface for a matte 
look.

Clear Coat Refraction Index
This slider controls the intensity of the clear-coat. 1.5 is a good general 
starting point. If a more shiny paint is desired, increase the value. 
Bringing the value down to 1 will almost "turn off" the clear-coat. This 
can be useful for making a matte finish or simulating plastics that have 
a metallic flake effect.

Metal Flake Size
This controls the size of the physical metal flakes within the paint 
surface. Increasing flake size makes the metal flake effect more 
apparent. By contrast, decreasing flake size makes the effect less 
apparent.

Metal Flake Visibility
This controls the opacity of the metal flake effect in the metallic paint 
material. A value of 0 causes the flakes to be completely transparent. 
At higher values the flakes blend in with the base color of the metallic 
paint material.

Material Types and Their Settings > Metallic Paint

Metal Color

Metal Flake Visibility
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Metal
The metal material type is a simple way to create polished or rough 
looking metal materials. It has very simple settings, just set the color 
and roughness and you are done.

Color
This controls the color of reflected light on the metal surface.

Roughness
This will add microscopic levels of imperfections to the surface of the 
material when the values are increased. When set to 0, a material will 
appear perfectly smooth and polished. When the value is increased the 
material will appear more rough as light is diffused across the surface.

Samples
To fully understand this parameter see the section on samples. A low 
samples setting (8 or lower) will tend to make the surface look more 
noisy which will give a more imperfect and rough look. As you increase 
the value the noise will even out more and provide a more evenly 
distributed roughness.

Material Types and Their Settings > Metal

Texture Maps Available

Color Specular Bump Opacity

Yes No Yes Yes
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Paint
The paint material is used when a metallic effect is not desired, but 
rather when a simple "gloss" paint is called for. It provides a quick way 
to set a color "base layer" then control the clear-coat on top.

Color
Color is your base layer of paint and the overall color of the material. 
Click the color thumbnail to open the color picker then select your 
desired color.

Roughness
This will add microscopic levels of imperfections to the surface of the 
material when the values are increased. When set to 0, a material will 
appear perfectly smooth and polished. When the value is increased the 
material will appear more rough as light is diffused across the surface.

A low samples setting (8 or lower) will tend to make the surface look 
more noisy which will give a more imperfect and rough look. As you 
increase the value the noise will smooth out and provide a more evenly 
distributed roughness.

Refraction Index
This controls the intensity of the clear-coat. 1.5 is a good general 
starting point. If a more shiny paint is desired, increase the value. 
Bringing the value down to 1 will almost "turn off" the clear-coat. This 
can be useful for making a matte finish or simulating plastics that have 
a metallic flake effect.

Material Types and Their Settings > Paint

Color Specular Bump Opacity

Yes Yes Yes Yes
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Plastic
The plastic material provide the basic settings needed to create simple 
plastic materials. Set the diffuse (overall color) and add some specular 
(reflections) then just dial in the roughness.

You can also create transparent plastics by controlling the transmission 
colors. This is a very versatile material type that is used for anything 
from concrete to woods.

Diffuse
This can be thought of as the overall color of the material. Transparent 
materials will have little or no diffuse.

Specular
This is the color and intensity of the reflection of light sources within 
the scene. Black will completely turn off reflections, while white will 
provide a very shiny plastic look.

Realistic plastic does not have color in the specular value, so generally 
you should use some level of gray or white. However, adding color can 
give the plastic material a metallic effect.

Material Types and Their Settings > Plastic

Color Specular Bump Opacity

Yes Yes Yes Yes
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Plastic
Roughness
This will add microscopic levels of imperfections to the surface of the 
material when the values are increased. When set to 0, a material will 
appear perfectly smooth and polished. When the value is increased the 
material will appear more rough as light is diffused across the surface. 

Within the roughness parameter you will find a samples setting. To fully 
understand this parameter see the section on samples.

A low samples setting (8 or lower) will tend to make the surface look 
more noisy which will give a more imperfect and rough look. As you 
increase the value the noise will smooth out and provide a more evenly 
distributed roughness.

Diffuse Transmission
This will cause additional light scattering across the surface of the 
material which can simulate a translucent effect. It will increase render 
time, so if it is not needed the recommendation is to leave it at black.

Specular Transmission
This can be thought of as the transparency of the material. Black will be 
100% opaque and white will be 100% transparent.

If a transparent glass or plastic is being created, the diffuse should 
be black with all the color derived from this parameter. Transparent 
glasses or plastics should also have the specular set to white. If a cloudy 
plastic is desired, the diffuse can be set to a very dark version of the 
color set here.

Material Types and Their Settings > Plastic

Roughness

Diffuse Transmission



KeyShot®
   Manual

Solid Glass
The solid glass material type provides a physically accurate glass 
material. When compared to the simpler glass material type you will 
find the solid glass simulates the effect color in the glass accurately as it 
takes into account the thickness of your model.

Color
This controls the overall color of this material type. When light enters 
the surface it will take on the color set here.

The amount of color that you see in this material is highly dependent on 
the transparency setting as well. If you have set a color, but it looks too 
faint, skip down to the transparency section.

Color Density
This setting controls how much of the color you have set in the 
transmission property you will see depending on how thick the part 
is that the material is applied to. This physically accurate parameter 
simulates the effect you can observe by looking at the color of the 
shallow water at a beach versus the deep blue of a deep ocean. Without 
color density you would see through to the bottom of the deepest 
ocean as easily as the bottom of a swimming pool.

After setting a color in the transmission setting, use the color density 
setting to make that color more or less saturated and prominent. A 
lower setting will show the color more in thin areas of the model, and a 
high setting will make the color faint in the thin areas.

Material Types and Their Settings > Solid Glass

Color Specular Bump Opacity

No No Yes Yes
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Solid Glass
Refraction Index
This controls how much light will bend or "refract" as it passes through 
parts on your model that have this type of material.

The default of 1.5 is accurate for simulating most types of glass, but you 
can increase the value to create a more dramatic refraction within the 
surface.

Roughness
Roughness on this type of material will spread out highlights on the 
surface similar to what you see on other, non-transparent, materials. 
However, it also spreads out the light that is transmitted through the 
material.

This is used to create a frosted glass look. 

Expand this parameter and you will see a samples setting. This can be 
used with a low setting to produce a more imperfect/noisy result or a 
higher value to smooth out the noise/grain for a smoother frosted look.

Material Types and Their Settings > Solid Glass

Color Density

Refraction Index

Roughness
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Thin Film
The thin film material produces an iridescent effect such that you would 
see with a soap bubble.

Refraction Index
The refraction index setting for this material provide more or less 
reflection on the surface. Increase the value to get more reflection 
intensity.

The actual colors you see in the thin film will also be affected by 
the refraction index. However, you can shift the colors with the next 
setting, so typically you will focus only on finding the desired amount of 
reflection with the refraction index setting

Thickness
Changing the thickness setting will shift the colors that you see on the 
surface using the thin film material.

Increasing the setting to a very high value will result in the effect of 
layers of colored rings on the surface.

100-1000 is a generally good range to stay within.

Material Types and Their Settings > Thin Film

Color Specular Bump Opacity

No No Yes Yes
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Toon
The toon material type allows you to create concept art from your 3D 
model. You are able to control the contour width, number of contour 
lines, and whether or not shadows are cast onto geometry.

Properties
Color - this will control the fill color of the toon material.

Contour Color - this will control the outline of the model.

Contour Angle - This will control the number of interior contour lines 
in the toon sketch. A lower value will increase the number of interior 
contour lines and a higher value will decrease the number of interior 
contour lines.

Contour Width - This will control how thin or how thick your contour 
lines will be.

Contour Quality - This will control the quality of the contour lines. Use a 
lower value to obtain a rough sketch look, or a higher value for a more 
clean and precise stroke.

Material Types and Their Settings > Toon

Color Specular Bump Opacity

Yes No Yes Yes
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Toon
Advanced
Contour width is in pixels - When this setting is enabled the Contour 
Width slider is calibrated to allow for finer contour lines. When this 
setting is disabled the Contour Width slider is calibrated to allow for 
thicker contour lines.

Outline Contour - This will allow you to show or hide the outline in your 
sketch.

Interior Edge Contour - This will show or hide the interior contour lines 
in your sketch.

Material Contour - This will allow you to show or hide the contour line 
that separates each unlinked toon material. If the toon material are 
linked this setting will not have an effect.

Environment Shadows - This will reveal the shadows cast by the model 
onto itself due to the lighting environment.

Shadow Multiplier - When Environment Shadows is disabled, this 
controls the value of the fill color. When Environment Shadows are 
enabled, this controls the lightness of shadows cast on the toon 
material.

Material Types and Their Settings > Toon
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Translucent
The translucent material type provides control over subsurface 
scattering properties that are found in many plastics and other 
materials.

Surface Color
This controls the diffused color of the outer surface of the material. 
Consider this the overall color of the material. Something to be aware 
of with this unique material type is that you will not see the translucent 
effect of the subsurface color if the surface color is completely black. 
Refer to the diffuse section for further information.

Subsurface Color
This setting controls the color that light will take on as it passes through 
the material and comes back out to your eye.

Your own skin is a great example of the subsurface effect. When a bright 
light shines through the thin parts of an ear or the thin skin between 
fingers, the light is colored by what lies beneath the surface and comes 
back more red.

While the light is passing through the surface is bounced around in 
many random directions. This creates the soft translucent effect rather 
than the direction refraction effect of a glass type of material.

For plastic materials you will often set this color to something very 
similar to the surface color. Perhaps just a bit brighter.

Material Types and Their Settings > Translucent

Color Specular Bump Opacity

Yes Yes Yes Yes
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Translucent
Translucency
This controls how deep light will penetrate into and through the 
surface. The higher your translucency value, the more of the subsurface 
color you will see coming through the surface.

Higher translucency values will also create a softer looking material.

Roughness
Increasing roughness will spread and distribute reflections over the 
surface and create a more matte surface.

Specularity
This controls the intensity of the reflections on the surface. 

Under the advanced category in this material type you will also find 
a refraction index setting. This can be used to further increase or 
decrease the strength of the reflections on the surface.

Material Types and Their Settings > Translucent
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Velvet
The velvet material is very useful for creating soft fabrics that have the 
distinct light catching effects that result from the soft fibers in finely 
woven fabrics.

This is a complicated material by KeyShot standards, and you will 
generally be able to do fabric materials well enough with the plastic 
or advanced material types. However, this material type does provide 
control over parameter not found in other material types.

Diffuse
This can be thought of as the overall color of the material. A dark color 
is generally preferred for both the diffuse and sheen settings as this 
material cab become unnaturally bright when light colors are used. 

Sheen
The sheen color is observed as light that appears to be reflected back 
across the surface from behind. Almost as though the surface is back 
light.

This setting is combined with the edginess control to add a soft sheen 
across the entire material. The backscatter parameter also gets its 
color from the sheen setting.

Generally this should be set to a color very similar to the diffuse color 
but just a bit brighter.

Material Types and Their Settings > Velvet

Color Specular Bump Opacity

Yes Yes Yes Yes
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Velvet
Roughness
The roughness setting determines how evenly the backscatter 
effect is distributed across the surface. When set to a low value the 
backscattered light will stay contained within smaller areas. A high 
value will spread the light across the entire object evenly.

Backscatter
This is light that scatters across the entire object and is especially 
apparent in the shadowed areas of the object. It can be used to give an 
overall soft look to the surface. The color of the backscatter light is set 
with the sheen control.

Edginess
This controls how far the sheen effect spreads over the surface. A low 
value will have the sheen fade out gradually, while a high value will 
produce a bright border of sheen around the edges of the surface. A 
setting of zero disabled the sheen effect.

Samples
The samples controls how imperfect or refined the backscatter effect 
appears. A higher values will smooth out this scattered light and will 
appear more even. A low value will show a coarser grain/noisiness in 
the backscattered light.

A higher setting, around 32, is often preferred for this setting as it 
provides a smoother result.

Material Types and Their Settings > Velvet
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Wireframe
The wireframe material exposes the lines and vertices of each polygon 
of the surface.

Wire Color
This controls the color drawn to each line in the wireframe

Base Color
This controls the overall color of material, excluding the lines(Wire).

Base Transmission Color
This value controls the base color transmission. A lighter color will give 
the appearance of transparency.

Backside Base Color
This controls the backside of the base color. On a cube this would be 
the inside of the cube base color.

Backside Wire Color
This controls the backside of the wire color.

Material Types and Their Settings > Wireframe

Color Specular Bump Opacity

No No Yes Yes
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X-Ray
The X-ray material provides a useful tool for illustrative renderings. It is 
often used to create a faded view through an outer shell of a product for 
viewing the internal components.

When applied to a surface the x ray effect works by showing more of 
the material color on areas of the surface that are being viewed a more 
of an angle. The surface is nearly completely see through where it is 
viewed at a direct angle.

Material Types and Their Settings > X-Ray

Color Specular Bump Opacity

No No Yes Yes
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Overview
The KeyShot animation system has been designed to make simple 
animations of moving components simple and easy to use. The 
animation tools are focused towards designers and engineers rather 
than entertainment professionals.

Animations are not created using a traditional keyframing system. 
Rather, they are applied as individual transforms to a model or part. 
Multiple transforms can be added to single parts and all transforms will 
be represented in the timeline as shown below. These transforms can 
be interactively moved and scaled in the timeline to adjust timing and 
change duration of animations.

Animation > Overview
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Animation > Concepts
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Translation
A translation is an animation where an part or model is moved on the 
XYZ axis to another location. Translations can be applied to parts or 
models by right clicking them in the scene tree and selecting "add 
translation," or through the animation wizard. Hierarchies from CAD 
systems will be maintained, allowing translations to be applied to 
entire assemblies and their individual components. When a translation 
is added, a translation by 1 unit on the Y axis will be created for a 1 
second duration in the timeline. The translation will be displayed as an 
icon in the scene tree under the component it has been applied. 

Animation > Concepts > Translation



KeyShot®
   Manual

Rotation
A rotation is an animation type where a model or part is rotated along 
an axis. This axis can be defined by the model/part using the local axis, 
by using the overall global axis of the scene, or by assigning a helper 
object to rotate around. There are also dynamic pivot points (see pivot 
points for more information.) 

Rotations can be applied to parts or models by right clicking them in 
the scene tree and selecting "add rotation," or through the animation 
wizard. Hierarchies from CAD systems will be maintained, allowing 
rotations to be applied to entire assemblies and their individual 
components. When a rotation is added, a rotation by 90 degrees 
on the X axis will be created for a 1 second duration in the timeline. 
The rotation will be displayed as an icon in the scene tree under the 
component it has been applied to. 

Animation > Concepts > Rotation
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Pivot Points
A pivot point is the point that a part/model will rotate around when a 
rotation animation is applied.

Center and Origin
By default your pivot point is the center point of the part/model that 
the animation is applied to. Changing to origin mode if your model 
has an origin point that coincides with the proper hinge point for the 
movement you desire.

Helper Object
A helper object gives the rotation a new point to rotate around. You can 
click "pick" and select any part of your model or bring in another model 
and use that as a helper object. Reset sets the helper object back to 
"self".

Tip: Want to freely control the pivot point? Just bring in a simple 
model(you can find some primitive shapes in the menu under Edit 
> Add Geometry), then use right click>move object to position this 
new model and use it as a helper object for your rotation animations. 
Continue to move the model and the animations will update their 
rotation based on the new position of the helper object.

Animation > Concepts > Pivot Points
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Pivot Points
Dynamic Pivot Points
This will allow the rotating part or model to follow a moving helper 
object. Dynamic pivot points should also be enabled when there are 
two or more rotations (each with different helper objects) applied to 
the same part or model. Not all moving helper objects will need the 
dynamic pivot points checkbox to be enabled. If a part orbits a helper 
object while the second is translated, the dynamic pivot point check 
box should remain unchecked unless the translation's axis orientation 
is "Original Local" and the rotation animation is applied at a higher 
hierarchy level. In that case the check box should be checked.

Animation > Concepts > Pivot Points
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Local and Global
Axis Orientation
When an animation is applied to a model or part you choose the X, Y, or 
Z axis for the movement to happen on. However, there are two states 
that these axes can be in.

In global mode the Y axis always points up. Even if you had rotated a 
part back in your modeling software, or even in KeyShot, when you 
animate this part and set the axis orientation to global the movement 
will be in this static, Y pointing up, state.

Local is not a static state. If you move a part, (ex. rotated it 45 degrees 
either in the modeling software or in KeyShot), then the local axes 
actually rotate and move with the part. If Y pointed up originally, 
rotating the part over 45 degrees means that Y axis is now also tilted 45 
degrees.

Think about an assembly held together by several screws. These screws 
were likely modeled on their own and lets say originally the Y axis 
pointed straight up from the head of the screw. The screw was copied 
several times and used in various places on a model. You can easily 
unscrew all of these screws with a translation set to move on the local Y 
axis and each screw will actually move up based on its own Y axis.

Setting these screws to use a global Y translation would mean they 
would move up in the same exact direct (straight up from the ground).

The diamonds in the image all use exactly the same setting, but notice 
how they have moved out from the ring each on their own local axis.

Animation > Concepts > Local and Global
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Fade
Quickly apply an animation that fades parts from one opacity level to 
another. Adjust opacity of parts and groups on-the-fly and see it update 
in real-time as animations are built.

The fade effect on a part or group of parts is created just like any other 
part animation. Right-click on the part or group of parts in the Project, 
Scene tree and select Animation, Fade. Adjust the Fade From/Fade To 
values to the desired setting along with easing and duration of fade 
through the properties to the right of the Animation Timeline. Using 
the Animation Wizard, select the Fade option as the Animation Type, 
then continue through the wizard selecting parts and adjusting fade 
settings.

Animation > Concepts > Fade
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Camera Orbit
Camera orbit rotates the camera around it's current "look at" point. 
Camera orbits can be added by right clicking on the camera in the 
scene tree and selecting "add orbit". This will apply an orbit that can be 
set in degrees. For information on setting the camera "look at" point 
see the section that covers cameras.

Animation > Concepts > Camera Orbit
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Zoom
Camera zooms dolly a camera in and out towards its current "look at" 
point. Camera zooms can be added by right clicking on the camera in 
the scene tree and selecting "add zoom". For information on setting the 
camera "look at" point see the section that covers cameras.

Animation > Concepts > Camera Zoom
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Translation
Camera translation allows the camera to move on the X, Y and Z axes. 
Camera translations can be added by right clicking on the camera in 
the scene tree and selecting "add translation".

Animation > Concepts > Camera Translation
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Motion Ease
Motion easing will create a more natural look when applied to rotations, 
translations and camera animations. This will add acceleration and 
deceleration to motion. For example, if a car goes from one stop sign 
to another and reaches a maximum speed of the 35 miles per hour, it is 
not traveling that speed for the entire time. The car has to start moving, 
accelerate to it's top speed and then slow down as it reaches the next 
stop sign. Without motion easing, the car would start, travel and stop 
35 miles per hour the entire time.

Animation > Concepts > Motion Ease

Linear

Ease In

Ease Out

Ease in/Ease Out
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Camera Switch Event
Switch cameras in your animation with the click of a button. KeyShot 
Animation users can now add camera switch events to change cameras 
on the animation timeline to easily incorporate other view angles 
without having to stitch together separate animations afterwards. 

With two camera animations set up, right-click on the camera you will 
start with and select Camera Switch Event to select the camera you 
want to switch to. This will add the event to the timeline, shown as 
an orange marker on a separate line. Select and drag the marker to 
the point where you want to switch to the other camera. Hit play, and 
watch as the animation switches cameras automatically.

Animation > Concepts > Camera Switch Event

Camera 1

Camera 2
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Motion Blur
KeyShot Motion blur provides a real-time preview of motion applied 
to models where movement is blurred. Capture the motion of objects 
as they rotate or move across the screen before you even play an 
animation or render an image.

To apply Motion Blur to objects in motion, check Motion Blur in the 
Project, Settings, Advanced options. If you already have objects with 
animations applied which move the object, the real-time view will 
update to show the object in motion.

Motion Blur can be seen quickly after turning the option on, by adding a 
Translation animation to an object or an Orbit animation to a Camera. 
The amount of motion blur is controlled through the Animation settings 
by adjusting how fast and how far an object or camera is moving. 
When Motion Blur is enabled, the real-time preview of the motion is 
dependent on the FPS setting.

Animation > Concepts > Motion Blur
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Overview
Animation Wizard
For beginners, the easiest way to create an animation is via the 
animation wizard. The animation wizard can be found in the animation 
timeline toolbar.

When you open the animation wizard, you are presented with 8 options, 
4 model/part animations and 4 camera animations.

Model Part Animation
This type of animation deals with moving or altering the geometry in 
the scene. The 4 types of model/part animation are:

Turntable
Translation
Rotation
Fade
Camera Animation
This type of animation is relegated to the movements of the camera. 
Before creating camera animations, it is suggested there are saved 
cameras already. The 4 types of camera animation are:

Orbit
Zoom
Inclination
Translation

Animation > Animation Wizard > Overview
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Animation Wizard
Turntable
Turntable animation rotates the model part along the global Y axis. 
Imagine placing the model or part on a turntable  and turning it while 
taking video. After selecting turntable and clicking next, Choose the 
model/parts that you would like to be included in this animation.

Rotation
You can set how much the model/part turns in this animation. It can 
be set to be a partial turn such as 15 degrees, or multiple complete 
rotations like 1080 degrees and more.

Center of Rotation
The default setting for the center of rotation is the local model Y axis. 
You can change the center to be the environment global Y axis if you 
want the model/part rotating around the center of the scene.

Direction
Choose the direction of rotation from clockwise or counter-clockwise.

Time Settings
Set the time the animation starts and ends, as well as setting the 
duration. Choose a motion ease setting here. See the section on motion 
ease for more information.

Motion Ease
Motion ease will control the acceleration/deceleration of a translation. 
When an option is hovered over in the drop down list, a preview of 
the acceleration/deceleration will be shown in the list. For more 
information on motion easing please see the section on motion ease.

Animation > Animation Wizard > Turntable
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Animation Wizard
Translation
This animation type moves the model part changing its XYZ coordinate 
location. Choose the model/part to be animated after selecting 
translation from the animation wizard.

Translate X/Y/Z
Set the distance traveled on the XYZ coordinates during the animation.

Axis Orientation
The default setting uses the model/part local axis to calculate 
translation animation. You can select global to move the model/part in 
relation to the XYZ coordinates of the scene.

Time Settings
Set the time the animation starts and ends, as well as setting the 
duration.

Motion Ease
Motion ease will control the acceleration/deceleration of a translation. 
When an option is hovered over in the drop down list, a preview of 
the acceleration/deceleration will be shown in the list. For more 
information on motion easing please see the section on motion ease.

Animation > Animation Wizard > Translation
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Animation Wizard
Rotation
This animation type rotates the model/part around the X, Y or Z axis. 
Choose the model/part to be animated after selecting translation from 
the animation wizard.

Rotation
Set how much the model/part turns in this animation.

Axis Orientation
Use the model/part origin or global origin for correct XYZ axis.

Pivot Point
Select an object to use as a pivot point (the default is self), and choose 
either origin or center as where it is located in relation to the part. 
Enable dynamic pivot point if using more than one rotation animation. 
For more information, see pivots.

Time Settings
Set the time the animation starts and ends, as well as setting the 
duration. Choose a motion ease setting here. See the section on motion 
ease for more information.

Motion Ease
Motion ease will control the acceleration/deceleration of a translation. 
When an option is hovered over in the drop down list, a preview of 
the acceleration/deceleration will be shown in the list. For more 
information on motion easing please see the section on motion ease.

Animation > Animation Wizard > Rotation
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Animation Wizard
Fade
After selecting fade in the animation wizard, choose the part or model 
that you would like to fade in or out in the animation.

Fade From
Choose the opacity level to start the animation at. If you want to fade 
in the part, start the opacity at 0. If you want to fade out, start the 
animation at 100.

Fade To
Set the final opacity level will be at the end of this animation node. To 
completely fade out, set the opacity to 0. To partially fade out, choose a 
number less than the "fade from" value.

Time Settings
Set the time the animation starts and ends, as well as setting the 
duration. Choose a motion ease setting here. See the section on motion 
ease for more information.

Motion Ease
Motion ease will control the acceleration/deceleration of a translation. 
When an option is hovered over in the drop down list, a preview of 
the acceleration/deceleration will be shown in the list. For more 
information on motion easing please see the section on motion ease.

Animation > Animation Wizard > Fade
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Animation Wizard
Camera Orbit
Camera orbit animation rotates the camera around the "look at" point 
assigned to that camera. After selecting Orbit animation, select a saved 
camera to animate.

Rotation
Set how much camera rotates in this animation.

Time Settings
Set the time the animation starts and ends, as well as setting the 
duration. Choose a motion ease setting here. See the section on motion 
ease for more information.

Motion Ease
Motion ease will control the acceleration/deceleration of a translation. 
When an option is hovered over in the drop down list, a preview of 
the acceleration/deceleration will be shown in the list. For more 
information on motion easing please see the section on motion ease.

Animation > Animation Wizard > Camera Orbit
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Animation Wizard
Camera Zoom
This Animation type brings the camera closer to the model. After 
selecting zoom, select a saved camera to apply the zoom animation.

Distance
Set the distance traveled during the animation.

Time Settings
Set the time the animation starts and ends, as well as setting the 
duration. Choose a motion ease setting here. See the section on motion 
ease for more information.

Motion Ease
Motion ease will control the acceleration/deceleration of a translation. 
When an option is hovered over in the drop down list, a preview of 
the acceleration/deceleration will be shown in the list. For more 
information on motion easing please see the section on motion ease.

Animation > Animation Wizard > Camera Zoom
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Animation Wizard
Camera Inclination
This animation type rotates the camera along the X axis, while keeping 
the "look at" point focused on a part. Select a saved camera after 
selecting inclination in the wizard.

Rotation
Set the amount of vertical rotation around a part the camera travels.

Time Settings
Set the time the animation starts and ends, as well as setting the 
duration. Choose a motion ease setting here. See the section on motion 
ease for more information.

Motion Ease
Motion ease will control the acceleration/deceleration of a translation. 
When an option is hovered over in the drop down list, a preview of 
the acceleration/deceleration will be shown in the list. For more 
information on motion easing please see the section on motion ease.

Animation > Animation Wizard > Camera Inclination
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Animation Wizard
Camera Translation
This animation type moves camera changing its XYZ coordinate 
location. Choose the saved camera to be animated after selecting 
translation from the animation wizard.

Translate X/Y/Z
Set the distance traveled on the XYZ coordinates during the animation.

Axis Orientation
The default setting uses the camera local axis to calculate translation 
animation. You can select global to move the model/part in relation to 
the XYZ coordinates of the scene.

Time Settings
Set the time the animation starts and ends, as well as setting the 
duration.

Motion Ease
Motion ease will control the acceleration/deceleration of a translation. 
When an option is hovered over in the drop down list, a preview of 
the acceleration/deceleration will be shown in the list. For more 
information on motion easing please see the section on motion ease.

Animation > Animation Wizard > Camera Translation
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Animation Wizard
Camera Switch Event
This event switches between two cameras instantly in the animation 
timeline. Choose a saved camera it is switching from after selecting 
camera switch event from the animation wizard.

From Camera
The origin camera the event is placed on.

To Camera
Select from the list of saved cameras to switch to.

Time Settings
Set the time event occurs in the timeline.

Animation > Animation Wizard > Camera Switch Event
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The Timeline
Animations are represented in the timeline and labeled according to 
the name set in the animation properties for translations, rotations and 
camera animations. When an animation node is clicked in the timeline, the 

properties will be displayed. Animations, can be shifted in time and scaled 
interactively to control timing and duration. Groups of animations can be 
consolidated in a single folder for organization. These folders can also be 
scaled and shifted to control timing and duration.

Animation > The Timeline > Overview

More >
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The Timeline Toolbar
Realtime Preview buttons
These buttons will allow you to quickly jump to the beginning or end 
of your animation, scrub through the animation one frame at a time, 
and play a realtime preview of your animation in the realtime render 
window. The preview play is only showing you the basic motions of 
the animations while rendering in realtime. To see a more accurate 
portrayal of materials and motion, click the "preview" button on the 
animation toolbar.

Loop
Enable this to have the animation loop when playing the realtime 
animation preview.

Preview
Click this button to begin rendering a small video file of your animation 
with more accurate results than the realtime preview.

Settings

Click the settings icon top open the settings panel. The settings panel 
contains adjustments for Frames Per Second (FPS), Timeline unit used, 
and the preview settings for when rendering a preview.

Animation Wizard
Opens the Animation Wizard. See section on Animation Wizard for 
details.

Zoom Slider
Change the scale of the timeline.

Animation > The Timeline > Timeline Toolbar

Realtime Preview

Loop Render  Preview

Settings Zoom Slider
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The Timeline UI
Time Stamp
This will show where the preview line currently is on the timeline

Preview line
This line will is the marker for the current state of where in the 
animation the realtime render window is rendering from. When you 
play a realtime preview, this line will move with in time with the 
animation. Click and drag the line to scrub to a point in the animation 
you would like to preview.

Start/End Markers
Designate the actual animation to be rendered. The space between is 
called the "work area" and can be selected in the render output.

Timeline
Shows the timeline in the units chosen (seconds, frames.)

Nodes
Each animation is represented in the timeline as a colored bar called a 
node. Most nodes can be selected at the ends and dragged to change 
the duration of the animation. Click on the body of the node to move 
along the timeline. Hold SHIFT while dragging to snap to another node.

Folder Nodes
Yellow Nodes are Folder Nodes. Changing the duration and location of a 
folder node affects all animation nodes contained within it.

Node List
Lists all animation nodes and folders. uncheck the node to disable.

Animation > The Timeline > Timeline UI
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Animation > The Timeline > Managing Nodes

Managing Nodes
Node management utilities can be found on the right click on nodes 
in the node list. To change the node order, or to move a node into 
an existing folder, click and drag the node in the node list. To multi-
select nodes, hold CTRL on a PC or Command on a Mac while selecting 
multiple nodes.

Delete
Select this option to delete an animation node(s) from the timeline.

Add Folder
Right click on a blank area in the node list to display this option.

Duplicate
Right click on the node(s) you would like to copy, and select this option.

Mirror
Right click on the node(s) you would like to have a reverse duplicate 
animation of. This is useful for exploded view animations, or where you 
need to have the animation end where it began for looping.
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Animation > The Timeline > Animation Properties

Animation Properties
Selecting a node will display its properties in the right side of the 
animation window. These parameters are the same parameters used in 
when creating an animation via the Animation Wizard. See the different 
animation types for more information. You can change the all existing 
animation parameters as well as changing the name of the node in the 
animation properties.

If the animation window is docked, or if you are using the window with 
a short window, you can compress sections of the properties to see the 
parameters that are most useful to you at that time.

Animation Properties
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KeyShot HDRI Editor
The KeyShot environment editor is a simple way to make adjustments 
to lighting environments. The editor adjustments and pins menu can be 
docked to the left or right side of the editor dialog.

Open the Editor
The KeyShot environment editor is opened my clicking the HDRI 
thumbnail.

KeyShot HDRI Editor > Overview

More >

Click "Edit HDRI" thumbnail to open HDRI editor
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KeyShot HDRI Editor Menu Bar
File
New HDRI
You can create an HDRI environment from scratch using this menu Item. 
You will be prompted to choose the resolution and background color 
for the new HDRI.

Open Image
While it is recommended to use an HDRI image file, or a KeyShot HDZ, 
the KeyShot HDRI editor allows you to use low dynamic range images 
such as JPG, PNG, and GIF.

Replace Image
Swap out the HDRI with another image file.

Save
Save the current HDRI to a KeyShot HDZ file.

Save As...
Save the current HDRI as an HDRI with a different file name.

KeyShot HDRI Editor > Menu Bar

New HDRI
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KeyShot HDRI Editor Menu Bar
Edit
Undo
This will list the last action executed in the HDRI editor. It is important 
to remember that the "undo" in the HDRI editor is a separate list of 
actions than the "undo" in KeyShot.

Clear Pins
Remove all pins from your pin list.

Generate High Resolution
While editing an environment the image is downsized to increase 
performance. To see the environment in full quality, use the "generate 
high resolution for KeyShot" option.

Use Super Sampling for High Resolution
Enable this for the best quality image for your environment.

KeyShot HDRI Editor > Menu Bar
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KeyShot HDRI Editor Menu Bar
View
Display Type
This will list the last action executed in the HDRI editor. It is important 
to remember that the "undo" in the HDRI editor is a separate list of 
actions than the "undo" in KeyShot. Toggle between Flat and spherical. 
Flat stretches out the HDRI to a flat rectangular image to edit with. 
Spherical displays the image on two circular projections that minimize 
distortion. Use the Display mode that suits your workflow.

Display Orientation
Choose an orientation that works best for you.

Reset View
After dragging your HDRI, click on reset view to move the HDRI back to 
the default position.

KeyShot HDRI Editor > Menu Bar
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KeyShot HDRI Editor Ribbon
The Ribbon in h the HDRI editor contains quick access to tools within 
the HDRI editor For more details on these tools, find the information 
within this section in the manual. The tools on the ribbon are:

Open 
Save 
Generate High Resolution 
Add Pin 
Add Copy Pin 
Add Image Pin

Show Ribbon
If the ribbon is not visible, go to window, and click "show ribbon" within 
the KeyShot  HDRI editor.

KeyShot HDRI Editor > Ribbon
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Adjustments
The adjustments tab contains simple sliders to enhance and fine tune 
the HDRI environment.

Saturation
Use the saturation slider to increase or decrease the intensity of color in 
the environment.

Hue
Use the hue slider to shift the colors of the environment.

The slider is in degrees, from 0 to 360, to represent the color wheel.

When shifting the hue of the environment, the resulting color is 
dependent on the starting point color. For example, if your environment 
is mostly red and the hue slider is set to 120, the resulting environment 
will be mostly green. If the starting point is green though, and the hue is 
again set to 120, the resulting environment will be blue.

Colorize
Use colorize to overlay one color on the entire environment image. The 
colorize color blends with the original environment colors, so the final 
colors will be a mixture based on the original colors, the saturation 
slider value, the hue slider value, and the colorize color.

In order to obtain a single color tone set the saturation slider to 0 then 
adjust colorize to your desired color.

KeyShot HDRI Editor > Adjustments
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Adjustments
Brightness
Use brightness to lighten or darken the environment.

Contrast
Use contrast to create a sharper lighting result (high contrast) or a 
softer lighting (low contrast).

The contrast value also controls how sharp the ground shadows in 
KeyShot will appear. A low contrast environment will show softer 
shadows.

Blur
Using the blur slider will blur the environment.

Tilt
Use the tilt dial to tilt the environment along the X axis. This is a great 
way to fine tune your reflections.

Rotation
Use the dial to rotate the environment along the Y axis. This works 
independently from the rotation that is found in the environment tab.

KeyShot HDRI Editor > Adjustments
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Adjustments
The adjustment settings are used to edit the entire HDRI environment.

Saturation
Use the saturation slider to increase or decrease the intensity of color in 
the environment.

Take the value down to 0 to completely desaturate the environment.

Hue
Use the hue slider to shift the colors of the environment.

The slider is in degrees, from 0 to 360, to represent the color wheel.

When shifting the hue of the environment, the resulting color is 
dependent on the starting point color. For example, if your environment 
is mostly red and the hue slider is set to 120, the resulting environment 
will be mostly green. If the starting point is green though, and the hue is 
again set to 120, the resulting environment will be blue.

Colorize
Use colorize to overlay one color on the entire environment image. The 
colorize color blends with the original environment colors, so the final 
colors will be a mixture based on the original colors, the saturation 
slider value, the hue slider value, and the colorize color.

In order to obtain a single color tone set the saturation slider to 0 then 
adjust colorize to your desired color.

KeyShot HDRI Editor > Adjustments
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Pins
The pins allow for targeted adjustments lighting in environment image.

Add Pin/Add Copy Pin/Add Image Pin
Places a new selected type of pin in the HDRI. The new pin will be 
displayed  in the Pin list, as well as the preview window. Select a pin in 
the pin list, or click on the pin handle in the preview window to make 
it active for editing. Drag the pins by the handle to position pins where 
you need them to go.

Delete Pin
Deletes the active pin.

Move Pin Up/Down
Changes the pin order in the pin list. The order is important as it will 
display and layer pins  from the top down.

Pin List
Contains all the pins created in the HDRI editor. You can enable and 
disable pins buy clicking the checkbox to the left of the name of the pin. 
You can rename pins by double clicking the name. Right pins for options 
to delete or duplicate. The Icon to the right of the name denotes the 
type of pin it is. The active pin being edited will be highlighted blue in 
the list, and will have a blue dot in the preview window.

KeyShot HDRI Editor > Pins
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Pins
Set Highlight
Adding and setting highlights can be achieved by clicking and selecting 
"Set highlight". This will bring forward the KeyShot realtime window 
where you can position your pin by selecting a region on the model you 
want to highlight. CTRL+Click anywhere on the surface of the model and 
a pin will be generated facing that point on the surface. When finished, 
click done. Pins added this way can be edited as normal.

KeyShot HDRI Editor > Pins
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Pins
Circular/Rectangular
This will toggle between the  shape of the pin. This is crucial when 
creating very specific shapes and reflections in your renderings.

Radius (Circular)
Determines circular pin size

Width/Height/Angle (Rectangular)
Determines the Shape for rectangular Pins.

Color
Set what color the pin will be projecting. For accurate real world 
lighting, use the kelvin scale for the color picker.

Blend Mode
Change from different ways the pins blend and interact with each other. 
Pin order layer becomes very important with this function.

Falloff
Controls the softness of edge of the pin light. Increase the falloff for 
more blended, softer edges.

Brightness
Adjust the overall intensity of the pin light.

KeyShot HDRI Editor > Pins
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Pins
Copy Pin
Copy Pins take a snapshot of the HDRI image and uses that image as 
a new pin. After selecting "Add Copy Pin," a pin handle with an orange 
outline will appear on the preview window. This will be the area of the 
image that will be copied to be used as a pin. Toggle between circular 
and rectangular for shape you want, and set the size and angle with the 
adjustment sliders. When finished Click on the green check to create 
the copy pin.

After creating the copy pin, move the pin by the handle to place it where 
desired. Adjustment sliders similar to the regular pin will be available 
with the same effects.

KeyShot HDRI Editor > Pins
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Pins
Image Pin
Image pins allow you to use HDR, HDZ, EXR, JPG, PNG,JPEG, and BMP 
as a pin. There are limitless usages for this pin such as creating specific 
reflections, simulating a lighting array, using part of a HDR with another 
HDR, among others.

When adding an image pin, you will prompted to select an image to be 
used. Once selected, the image will be placed in the preview window.

Adjustment sliders will be available to edit the image pin. These sliders 
are similar to the regular pin sliders. See the beginning portion of this 
section on pins for more information on the slider effects.

KeyShot HDRI Editor > Pins

Reflected image pin
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Sun and Sky
You can create accurate outdoor lighting with the sun and sky system in 
the KeyShot HDRI editor. 

Resolution
Set the resolution of your sun and sky that will be generated. A smaller 
resolution has better performance, but a larger resolution has better 
shadow and reflection quality.

Location
Choose a preset city that is closest to where the scene is taking place 
for accurate portrayal of the sun and seasons at location.

Coordinates
Enter custom geo coordinates of a location.

Date
Adjust the date to the day the scene will be taking place for accurate 
portrayal of color temperatures of seasons.

Time
Set the time the scene takes place for placement of the sun.

Turbidity
Increase to add more haze to the sky. This will tint the sky with a warm 
tone, as well as filter the sunlight that is cast in the scene.

KeyShot HDRI Editor > Sun and Sky
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Sun and Sky
Keep Pins
Enable this feature to keep any pins created when generating a sun and 
sky HDRI.

Keep Environment Settings
Enable this feature to retain environment settings when generating a 
sun and sky HDRI.

Keep Adjustments
Enable this feature to retain adjustments to the HDRI when generating 
a sun and sky HDRI.

Generate HDRI
Once your settings are complete, click this button to replace the HDRI 
with a sun and Sky HDRI. Caution: clicking this will remove the previous 
HDRI. Make sure if you want to save your previous HDRI, save it first 
before you click "Generate" HDRI.

KeyShot HDRI Editor > Sun and Sky
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Overview
KeyShotVR gives you the ability to bring your 3D renderings to 
interactive webpages. With KeyShotVR you can create high-quality, 
touch-enabled, 3D rendered content capable of being displayed in 
any web browser supporting HTML5. The content can be viewed using 
mouse or finger on touch-enabled devices and does not require a 
browser plugin to work.

KeyShot VR > Overview
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Setting up a VR
The VR option will be located on the ribbon or with the hotkey "V". 

Clicking the KeyShotVR button will open the KeyShot wizard dialog with 
four types of VR modes you can choose from. Selecting one of the four 
VR modes will show you a preview of the model's rotation.

Next, you will be able to select the center of rotation for your VR. With 
three options. This will dictate the center of rotation of the VR After 
selecting a center of rotation. Click next after you have selected.

Environment
Set the center of rotation at the center of the environment.

Object
Select an object in the scene as a center of rotation.

Custom
Allows you to select the center of rotation.

KeyShot VR > Setting up a VR
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Setting up a VR
The VR option will be located on the ribbon or with the hotkey "V". 

Clicking the KeyShotVR button will open the KeyShot wizard dialog with 
four types of VR modes you can choose from. Selecting one of the four 
VR modes will show you a preview of the model's rotation.

Next, you will be able to select the center of rotation for your VR. With 
three options. This will dictate the center of rotation of the VR After 
selecting a center of rotation. Click next after you have selected.

Environment
Set the center of rotation at the center of the environment.

Object
Select an object in the scene as a center of rotation.

Custom
Allows you to select the center of rotation.

KeyShot VR > Setting up a VR
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Setting up a VR
In this step you will be able to control the smoothness of the VR. 
Higher the number of horizontal and vertical frames will increase the 
smoothness of the rotation on the model inside a web browser, but will 
also increase the total number of frames to be rendered.

In this last step you will be able to configure the output of the VR, as 
well as the image resolution for each frame.

KeyShot VR > Setting up a VR
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Generating KeyShotVR From Animation
If an animation is applied to the model, it can be set as the KeyShotVR 
mode. Any animation type can be included as a KeyShotVR.

Select Animation at the first step in the KeyShot Wizard.

Next, you will be able to select the time range of the animation.

Resulting FPS
This will give the overall smoothness of the KeyShotVR when using in 
the browser. Higher value will give a more smooth transition.

Object
Gives you the ability to select an object in the scene as a center of 
rotation.

Loop Animation
Will give an infinite looping in the browser.

Additional options can be made by selecting "Render options" at the 
end of the wizard.

KeyShot VR > Generate KeyShotVR from Animation
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KeyShotVR Render Output
Click :"Render Now" to render immediately, or click "Render Options" 
to open the render options window to review your VR settings. All the 
parameters set in the wizard can be edited in the render output window 
as well. In Addition, there are other options such as image quality, and 
outputting for an iPad. There is also an option in this window to output 
directly to a website you are managing.

From here, you can select render quality, queue, network, and more. 
See the section on rendering for more information

Smoothness Control
Animation Frames
If animation is applied to the scene you will be able to create a VR from 
this animation. Additional parameters will be shown if enabled.

Horizontal Frames
Controls the number of frames in the 'X' direction, the higher the 
number of frames the smoother your model will rotate.

Vertical Frames
Controls the number of frames in the 'Y' direction, the higher the 
number of frames the smoother your model will rotate.

Horizontal/Vertical Angle Increments
Sets the degrees between each frame, this value will change depending 
on the number of vertical and horizontal frames, and starting and 
ending angles.

KeyShot VR > KeyShotVR Render Output
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KeyShotVR Render Output
Angle Control
Use these sliders to control the beginning and ending of the VR.

Horizontal- controls the beginning and end of rotation on the 'X' plane.

Vertical- controls the beginning and end of rotation on the 'Y' plane.

VR Output
This section allows you to set up the resolution as well as the 
destination of the VR

Image Quality- selecting the "Preview" button will render one frame 
from the VR as well as a compression slider that allows adjustments to 
the quality of the image, and updates in realtime.

iBook Widget - if checked an HTML5 widget will be output in the same 
folder as your KeyShotVR that can be used inside of iAuthor to embed 
KeyShotVR. The type of iPad the KeyShotVR should be selected from 
the dropdown.

KeyShot VR > KeyShotVR Render Output
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Advanced Settings
Advanced settings for KeyShotVR will be located on the same window 
as the custom settings, as a drop down menu. This menu will control 
how your VR interacts in the web browser.

Re-sizable GUI Button
If this field is checked, it will place a button on the VR in the webpage 
that allows you to resize to fullscreen or fixed window size.

Play GUI Button
If this field is checked, a play button will be placed inside your web 
browser, allowing interaction with the VR once pressed.

Allow Fullscreen Mode By Double-Click
Double-clicking left mouse button will enter fullscreen mode.

Loading Screen
The loading icon will be shown if the KeyShotVR is loading in the 
browser. This can be changed by selecting "Browse" and browsing to 
the image file.

Name of Div
This defines the VR section in the HTML code.

Rotation Damping
Increasing the value will increase the smoothness of the camera 
rotation when panning inside the web browser.

KeyShot VR > Advanced Settings
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Advanced Settings
Mouse Sensitivity
Controls the overall mouse sensitivity to the VR. Increasing this value 
will increase the model movement with less mouse movement.

Zoom-In
Enabling zoom-in will allow you to zone in to the VR when inside the 
browser.

FTP Deployment
This will allow your VR to be uploaded to a FTP site automatically.

Confirm Before Deployment
When the VR is finished rendering, you will be prompted to accept the 
deployment to the FTP site.

Generate Embeddable HTML Code
This will give you the code necessary for implementing your VR in a 
website using the iframe tag.

Embed FTP Settings in BIP File
This will save all the FTP credentials inside your BIP for easy 
deployment by another user.

Render Mode
KeyShotVR can be rendered using Default, Background, Network 
Rendering, and Queue for later processing of the VR.

KeyShot VR > Advanced Settings
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Final Output
Once the VR has finished rendering, the web browser with the finished 
VR will be displayed. Additional settings can be set in the HTML code 
that was produced with the VR. You can find the HTML code along with 
all the render frames in a folder at your saved location.

KeyShot VR > Final Output
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Embedding KeyShotVR in a PowerPoint Presentation
To embed KeyShotVR inside a PowerPoint presentation, you will need 
to download the LiveWeb add-in which can be found here: LiveWeb

Once it has downloaded, extract the files. In PowerPoint , open the 
Options window. In PowerPoint 2010, you can do this by clicking the 
File button and selecting Options; in PowerPoint 2007, click the Office 
orb and select Options. Select Add-Ins on the left side, then select 
PowerPoint Add-ins from the Manage menu, and click Go.

This will open the PowerPoint Add-ins window. Click Add New to add 
the LiveWeb add-in you downloaded previously. Browse to the folder 
you extracted the LiveWeb.ppam add-in and add it. PowerPoint may 
warn you that the add-in contains a macro. Click Enable Macros to 
continue.

You should now see the LiveWeb add-in in the Add-Ins window and you 
ready to add a KeyShotVR to your PowerPoint.

KeyShot VR > Embedding KeyShot VR in PowerPoint
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Embedding KeyShotVR in a PowerPoint Presentation
This will open the PowerPoint Add-ins window. Click Add New to add 
the LiveWeb add-in you downloaded previously. Browse to the folder 
you extracted the LiveWeb.ppam add-in and add it. PowerPoint may 
warn you that the add-in contains a macro. Click Enable Macros to 
continue.

You should now see the LiveWeb add-in in the Add-Ins window and you 
ready to add a KeyShotVR to your PowerPoint.

KeyShot VR > Embedding KeyShot VR in PowerPoint
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Embedding KeyShotVR in a PowerPoint Presentation
To add a KeyShotVR to your PowerPoint. From the Insert tab, select 
Web Page from the LiveWeb section.

This will open a quick wizard, that will guide you through inserting 
a webpage into your PowerPoint. If your KeyShotVR is stored on a 
webserver(e.g. website) you can use the URL, make sure to include 
http:// in front of the web address.

You can also add a KeyShotVR stored on your own machine. You will 
need to use the absolute filepath to the KeyShotVR html file(e.g. 
C:\Users\Luxion\Documents\KeyShot 3\Animations\KeyShotVR\
KeyShotVR.html)

Click Add, Next.

The remaining settings on the wizard can be configured any way. 
LiveWeb will let you know at the end of the wizard if the webpage was 
successfully added to the PowerPoint presentation.

You should now see a Windows 98 style logo inside your presentation of 
where the KeyShotVR will be located. You are able to resize and move 
the KeyShotVR inside the presentation, if you want.

To start viewing the KeyShotVR you will need to start the PowerPoint 
presentation(F5). You will now be able to interact with the KeyShotVR 
as though you are viewing inside a web browser. Additionally you can 
mark up the slide as you would with any other PowerPoint tools.

KeyShot VR > Embedding KeyShot VR in PowerPoint
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